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Micro Focus Enterprise Developer 2.3
Update 1 for Eclipse Release Notes
These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.
Note:
•

•

This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.
Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Product Overview
Enterprise Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM
DB2, IBM z/OS file formats and common batch utilities, including SORT. This means that you can develop
and maintain the core mainframe online and batch applications under Enterprise Developer. You can then
deploy these applications back on the mainframe or migrate them onto one of the Micro Focus Linux, UNIX
or Windows-based production platforms.
Micro Focus offers Enterprise Developer with the following licensing options that unlock different
functionality:
•

Micro Focus Enterprise Developer Personal Edition

•

Enterprise Developer Personal Edition is a free product, available for download. It is suitable for anyone
who wants to become familiar with the Eclipse or Visual Studio means of editing and compiling
mainframe applications under Windows.
Micro Focus Enterprise Developer Connect

•

Enterprise Developer Connect is for customers looking to use modern and productive Eclipse-based
tooling to develop mainframe applications directly on the mainframe. Close integration to mainframe
configuration management systems and the ability to easily customize the Eclipse-based IDE to include
mainframe-based tools and processes means developers can take full advantage of modern
development tools without having to learn new development processes.
Micro Focus Enterprise Developer

•

Enterprise Developer is for customers looking to develop and modernize mainframe applications in a
productive and modern Windows-based development environment, targeted for deployment onto an
alternate server platform. Developers have the choice of either the Visual Studio or the Eclipse-based
IDE and development and test tools are provided for all target environments currently supported by
Micro Focus.
Micro Focus Enterprise Developer for z Systems
Enterprise Developer for z Systems gives customers the choice to develop directly on the mainframe or
under Windows. Mainframe applications can be developed, maintained and modernized regardless of
where they will be deployed, either back onto the mainframe or onto an alternative server environment.
Support is provided for both the Visual Studio and Eclipse-based IDEs and for all the development and
test tools for every target environment currently supported by Micro Focus - including z/Linux, AIX and
x86 environments.
Enterprise Developer for z Systems combines all the capabilities of Enterprise Developer Connect and
Enterprise Developer.
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Full mainframe integration and the Application Workflow Manager are only available in the Eclipsebased IDE.
Note:
•

The Application Workflow Manager is available within all Enterprise Developer variants and
provides all the capabilities and tools to develop and maintain Application Workflow models. These
models allow you to integrate tools and processes directly into Enterprise Developer. You can use
the Application Workflow Manager with the following products:
•
•

Enterprise Developer - the Enterprise Developer setup file automatically installs the Application
Workflow Manager.
IBM Rational Developer for System z (RDz) - see Installing Application Workflow Manager into
Rational Developer for System z (RDz) in the installation instructions. This requires that
Enterprise Developer Connect is installed and licensed.

Upgrading from earlier Micro Focus products
Application executables that were compiled using earlier Micro Focus products must be recompiled from
the sources using Enterprise Developer. For more information, read the section Upgrading to Enterprise
Developer in the product Help.
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What's New
This release provides enhancements in the following areas:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Integration with Eclipse
Application Workflow Manager
Application Server JCA support for Enterprise Server
Code analysis
Code coverage
Compiler directives
Enterprise Server
Data File Tools
Database Access - HCO for SQL Server
Database Access - Mainframe Batch Database Tools (MBDTs)
Database Access - SQL Option for DB2
Editor writing assistance
File Handling
iFileshare - Fileshare under Enterprise Server (Early Adopter Product)
Library routines
Mainframe support and emulation
Micro Focus Unit Testing Framework
Managed COBOL syntax
Native COBOL syntax
PL/I support
Rosetta Stone for COBOL, .NET and Java Developers
SourceConnect
z/Server Configuration Utility

Integration with Eclipse
Back to Top
This release provides enhancements in the following areas:
Editors:
•

COBOL editor:
•

•

•

You can now specify the increment for the COBOL and the standard line numbering from Window >
Preferences > Micro Focus > COBOL > Editor > Line numbering.
• You can now toggle single or multiple lines between commented and uncommented states.
JCL editor - the Unnumber and Renumber commands are now supported for the JCL editor. You can
specify the line number increments from the IDE preferences in Window > Preferences > Micro Focus
> JCL > Editor > Line numbering.
PL/I editor:
•

•

The Unnumber and Renumber commands are now supported for the PL/I editor. You can specify the
line number increments from the IDE preferences in Window > Preferences > Micro Focus > PL/I
> Editor > Line numbering.
You can now toggle single or multiple lines between commented and uncommented states.

Building applications:
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•

Environment variables - a new page, Build Environment, in the project's properties enables you to
specify environment variables for your applications. You can also specify environment variables that only
apply at run time on the run or debug configuration for the application.

Application Workflow Manager
Back to Top
New features and enhancements are available in the following areas:
•

AWM modelling:
•

•

•

It is now possible to associate keyboard shortcuts with modeled actions. The key sequence is
displayed in the corresponding context menu at run time.

Currently, it is not possible to persistently overwrite any modelled key bindings with user key
bindings.
• Support is provided for table row updates in modeled AWM dialogs - it is now possible to use table
row actions in in the modeled AWM dialogs to modify table rows similarly to how this is done in the
Team Developer Tree or in the Table views. The supported modifications are copy, delete, insert and
update of selected rows.
• It is now possible to hide element properties in an AWM element's property view using the "Element
Type has Property" condition.
• The "Get Children" attribute of an element type has been replaced by the "Element Type has Get
Children Action" relationship between an element type and an action descriptor which enables you to
check whether an AWM container element can be expanded.
Full support and a seamless integration is now available in the IDE for the AWM SCM models for
ChangeMan, Endevor and SCLM. You can now check out sources from the SCM system directly into
your COBOL or PL/I projects in the IDE and vice versa.
AWM Run-Time:
•

•

•

•

A single port for server connection - starting with this release you now only need to specify one port,
the Mainframe Access (MFA) server port, for the Micro Focus z/Server connection type in the
Remote System view. All other required ports are configured centrally in the server configuration on
the mainframe. You must install the latest version of z/Server.
It is still possible to connect to an earlier supported version of z/Server. There is a backward
compatibility flag that must be enabled to be able to specify the three ports that are required with the
earlier z/Server version.
SSL support - it is now possible to specify a SSL/TLS configuration when defining a new Micro
Focus z/Server connection in the Remote System view. The client then uses the configured
SSL/TLS certificates for the communication with the server. The mainframe must support SSL/TLS
tunneling (such as AT-TLS from IBM).
RACF passticket support - AWM clients now include an extension point which you can use to provide
user credentials from an external application. When connecting to a Micro Focus mainframe server
system (either MFA or z/Server), the password dialog is then bypassed. This enhancement enables
you to integrate a login mechanism that uses RACF passtickets instead of RACF passwords.
Support for binary download and upload of files - it is now possible to specify a Transfer Mode (either
text or binary) in the file mapping dialog of the File Mappings view when transferring files between
the mainframe and the local machine such as when editing files or during a drag and drop operation:
•
•

•

Text - the configured code pages are respected.
Binary - no code page translation is applied. You must use binary mode when transferring
mainframe load modules.
The SVN attachment is now an integrated part of the Enterprise Developer and is installed as part of
the product. This enables you to use the tools from the SVN function package in an AWM model. For
example, you can extend an existing model by adding the check-in and check-out functions for
sources in an SVN repository. A sample model that includes a full integration of SVN support in the
Enterprise Development Project model is available.
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•

•

A new AWM "MVS Projects Sample Application" is available with the installation of z/Server. The
application uses the tools from the MVS and ISPF function package and is designed as a template
AWM application for project-based access to MVS data.
The AWM Enterprise Development Projects Application now provides the following enhancements:
•
•

•

Web Services support for COBOL applications in the Team Developer perspective.
Context menu commands for performing code analysis on demand of the sources in your projects
from the Team Developer Tree and Table views.
• An Open in context action for COBOL copybooks in the Team Developer Tree and Table views.
• An Import and Export are wizards from the context menus of the Team Developer Tree and Table
views.
• Error markers in the Team Developer Tree and Table view on project, folder and file level when the
sources compile with errors.
• A "Link with Editor" function in the Team Developer Tree view for such files that you viewed when you
expanded the tree view.
• Support for using filters (using Customize View > Filters) in the Team Developer Tree and Table
views to specify what entries should be displayed.
• An improved support for drag and drop between the Team Developer Tree and Table view and the
standard Eclipse views (such as Project Explorer and the Navigator view), the Remote Systems view
(from the local and the Micro Focus z/Server connections), and Microsoft's Windows Explorer.
The product help now includes a new section, AWM API Programming and Extension Points, that
describes the published AWM API classes and interfaces and the extension points provided by the
AWM client. Use cases for the usage of the AWM API and extension points and a detailed tutorial
showing how to extend the main AWM extension point, com.microfocus.awm.model.extension, are also
available.

Application Server JCA support for Enterprise Server
Back to Top
This release provides support for:
•

•

Automatic connection recovery to an active Java application server when an enterprise server region is
restarted. This applies to:
• COBOL resource adapters
• CICS resource adapters
• All CICS API based programs
The IBM implementation of CICS resource adapter for WebSphere 8.5 and JBoss 7.1.1.

Code analysis
Back to Top
This release provides support for performing code analysis at the command line using Ant which enables
the integration of code analysis in CI frameworks. Features include:
•
•
•
•
•
•

8

| What's New

Support for performing code analysis at the command line using the project's .cobolBuild Ant script
and specifying a target.
New Ant targets for code analysis - analyze and build.and.analyze. These enable you to only run
analysis and produce analysis data or to build and produce build artifacts as well as analysis data.
New Micro Focus Ant task, analysis, for the .cobolBuild file. A parameter for this task enables you
to specify whether the build fails or continues when code analysis results are received.
New parameters for code analysis for the cobol Ant task - analysisData, analysisDataDir.
New Ant type, ruleList, for the .cobolBuild file - enables you to specify the rules to execute.
Support for running analysis using a custom .cobolBuild file from outside of the project directory or
the workspace.

See the Micro Focus Ant User Manual in the Micro Focus Infocenter for more details on the new task, types
and parameters.
Code coverage
Back to Top
The code coverage reports are now integrated with the IDE and with the editor. Features include:
•
•
•

A new Code Coverage view (Eclipse) showing the statistics of what percentage of the code has
executed.
Navigation from the Code Coverage view (Eclipse) to the missed and covered blocks in the editor.
Colorization in the editor of blocks that were executed (covered blocks) or not (missed blocks).

Compiler directives
Back to Top
The following Compiler directives contain new parameters in this release:
•

•

ILMAIN - you now specify the main entry point for the executable program, which can be specified either
as class-name::method-name, or just as method-name. For example, ILMAIN"classA::methodB" or
ILMAIN"methodB". The first format can be used to distinguish between multiple methods with the same
name in different classes.
This directive is now available for JVM COBOL.
OOCTRL - a new parameter, +/-A, as been added. Set this parameter to -A to allow ActiveX controls in
your COBOL application to use classes and methods in the OLE class library. The default is +A, which
does not allow it.

Data File Tools
Back to Top
This release provides improved security and increased support for more file types. Features include:
•

•

•

Certain aspects of Enterprise Server security are honored when you attempt to access data sets. If the
Enterprise Server region has security enabled, logon details must be authenticated before you can
access the data set. If the details are unable to be authenticated, access is denied.
When using a record layout, certain data is now validated at field level (to ensure the contents is
compatible with its picture string ) and record level (to ensure the record length matches the layout
size).
Full editing support has been added for variable block sequential files and relative files. Full editing is
also available for line sequential files, as long as they do not contain any binary data.

Database Access - HCO for SQL Server
Back to Top
This release provides the following new features:
•

•
•

End-to-end demonstrations that show several methods for submitting a JCL batch job that calls COBOL
stored procedures. To view these demos, see the SQL demonstrations in the Mainframe Samples
browser.
The SPCALLLOCAL SQL compiler directive option, used to convert an EXEC SQL CALL into a call to a
local COBOL subroutine instead of a call to a SQL Server SQLCLR stored procedure.
Extended support for conversion of the DB2 CONCAT function.

Database Access - Mainframe Batch Database Tools (MBDTs)
Back to Top

What's New
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Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use and it
is not supported as such.
This release provides MBDTs support for DB2 LUW partitioned tables.
It also provides support for 32-bit MBDTs for use with DB2 LUW on the following platforms:
•
•
•

IBM System p running AIX
x86-64 running SUSE Linux
x86-64 running Red Hat Linux

Database Access - SQL Option for DB2
Back to Top
This release provides the following new features:
•
•
•
•

Import/export of XML with SQLWizard/DSNUTILB(XUTLB)
New XDBSetup utility for TS/Citrix environments
Using Migrate to move XML tables from z/OS DB2 to XDB
Support for Temporal Tables

Eclipse editor coding assistance
Back to Top
This release includes various improvements in the Content Assist support for COBOL in the following
areas:
•
•

•
•
•

Native COBOL - support is now available for OCCURS statements
Managed COBOL - suggestions are now available in the working storage section and in the following
scenarios:
• Arithmetic expressions in method arguments
• Casting variables and some expressions
• Creating arrays using the TABLE OF expression and indexers
• Generics
• Implements and inherits
• Javadoc comments are now displayed (Eclipse)
• Type name filtering in constructs and attributes
• Managed type headers, method heathers and index headers.
• Nested types
• SIZE OF expressions
• String concatenations
• TYPE OF constructs
• Unqualified members access - using the SELF:: or SUPER:: syntax
Support for float literals has been enhanced.
Suggestions are now available for more COBOL verbs such as TRY and RAISE (in managed COBOL)
and EXAMINE, INSPECT, SEARCH, GO TO, INITIALIZE, INVOKE, and UNLOCK (in native COBOL).
There are new IDE configuration settings for inserting suggestions and for case handling.

Enterprise COBOL 5.2
Back to Top
With the introduction of Enterprise COBOL 5.2, the following features are supported:
•
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The VOLATILE keyword is supported within the data entry description; although, this is treated as
documentary. It has also become a reserved word when under the ENTCOBOL dialect.

•
•
•

Format 2 of the SORT statement no longer treats the COLLATING SEQUENCE clause as
documentary-only.
The SUPPRESS clause of the XML GENERATE statement has been enhanced.
The IBM z/OS JSON parser API, as documented for the IBM z/OS client web enablement toolkit.

Enterprise Server
Back to Top
This release provides support for the SO_RCVTIMEO and SO_SNDTIMEO timeout options of EZASOKET
support that help reduce the risk of applications becoming unresponsive due to EZASOKET APIs not
completing.
File Handling
Back to Top
The following enhancements have been made to file handling processes:
•

•

A new indexed file format, IDXFORMAT12, has been introduced to improve file maintenance and
recovery procedures when using the rebuild utility. This file format is similar in structure and use to
IDXFORMAT8. Where the two formats differ is that an IDXFORMAT12 file has an accompanying side
file (.idx file) containing the indexed key information.
You can use this type of file with the new rebuild /q option. This rebuild process is considerably
quicker than other rebuild processes such as a data scrape or rebuild /p.
Faster SORT operations for fixed block records - when using the DFSORT emulation, the performance
when sorting fixed block records has greatly improved.

iFileshare - Fileshare support under Enterprise Server (Early Adopter Product)
Back to Top
Attention: This feature is in Early Adopter Product (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact Micro Focus SupportLine if you require further
clarification.
You can configure iFileshare to offer enhanced availability for mission critical files by configuring a high
availability group, consisting of a primary iFileshare server and a number of stand-by servers.
Files that are critical to your application can be replicated from a primary server onto the stand-by servers.
Should the primary server fail, you have up-to-date data (minus any in-flight transactions) available.
If Enterprise Server work is being hosted on the primary region within the group, the setup must be
consistent on all standby Fileshare hosting regions so that work can continue in the event of a failover.
Library routines
Back to Top
The following library routines are new in this release:
•
•

CBL_CODESET_SET_MAPPING - enables you to change the codeset in effect.
CBL_RUNTIME_ERROR - forces an application to terminate with a run-time error condition.

Mainframe support and emulation
Back to Top
This release provides the following enhancements:
•

Enterprise Developer includes a new utility, MFJPTPCH, that emulates the IEBPTPCH mainframe utility
for printing or punching datasets.

What's New
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•
•
•

Support for using multiple catalog files (up to 32).
Support for storing the spool files in a location that differs from the location of the catalog file.
Enhanced support for searching the catalog using wildcards.

Micro Focus Unit Testing Framework
Back to Top
This release provides the following enhancements:
•

Updates to the test runner command line options:
•
•

Using the -testcases: option, you can now specify a list of test cases to execute.
The new -report:markdown option enables you to produce test reports in github style markdown
format (.md).

•

You can use various Third-Party utilities such as pandoc to convert .md files into HTML or PDF
format.
Support for running test suites using dynamic metadata - you use an entry point in the test case and,
when it is called during the preparation stage of the test case, you can change various fields exposed
through mfunit.cpy to update the metadata of the test case.

•

This is an alternative to specifying metadata for a test case in the text fixture file (.mfu).
Support is now available for creating and debugging test cases written in procedural managed COBOL
(procedural code compiled as managed). The following new test runners are supplied:
•
•

mfurunil, for .NET COBOL code
mfurunj (Windows) and cobmfurunj (UNIX) for JVM COBOL code.

Managed COBOL syntax
Back to Top
The following enhancements have been made to the managed COBOL syntax:
•
•
•

A new command line utility, mfjarprogmap, is available to allow you to create the necessary Java
property file when calling COBOL programs that have been compiled as part of a package.
You can now create generic iterators.
You can now use the Profiler utility to obtain detailed statistics on the run-time performance of managed
COBOL applications.

Native COBOL Syntax
Back to Top
The following items are new features of the native COBOL syntax:
Class condition tests New and updated class condition tests are available for DBCS, KANJI, and
JAPANESE.
PL/I support
Back to Top
Support is available for the following features:
•

•
•
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FIXED BIN(63) data type - PL/I programs that utilize FIXED BIN data types that are larger than FIXED
BIN(31) are now supported which enables you to migrate such programs more easily to distributed
platforms.
TRIM() built-in functions - the Open PL/I macro preprocessor now supports the TRIM() built-in function.
A 64-bit Open PL/I peephole optimizer - when compiling 64-bit Open PL/I programs optimization for
speed, a peephole optimizer is now run against the intermediate code to improve your applications'

performance. Any code which has attributes that benefit from peephole optimizations will then run
faster.
Rosetta Stone for COBOL, .NET and Java Developers
Back to Top
The product Help now includes a quick and easy to use syntax guide for developers who need to learn OO
COBOL syntax when modernizing COBOL applications for the Java or .NET platforms. The guide includes
side-by-side equivalent syntax for COBOL, C#, VB and Java.
SourceConnect
Back to Top
It is now possible to use SourceConnect to link to mainframe locations and to define mainframe datasets
and members. The datasets and members then appear in your project's directory structure within the IDE.
z/Server
Back to Top
The z/Server Configuration Utility is now installed as part of Enterprise Server and is not a Technology
Preview download. The user interface has been streamlined for the creation of a default working
configuration.

What's New
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•

Application Workflow Modeller
AppMaster Builder
Communications Server
Data Tools
Editor Writing Assistance
Enterprise Server
IBM Language Environment for OS/390 & VM Support
IDE
JCL Support
Run-Time System
SQL: OpenESQL
SQL Option for DB2

Application Workflow Modeller
Back to the list
•

Tools used in the File_Descriptor_Has_Action relationship now support Resource Processing. This
means tools defined within a dialog table action can modify properties of the selected table rows.

•

2835290 (1101493)
The standard ED project model now contains additional context menu actions under "Open With..." for
IMS DBD and PSP files to open either the DBD, the PSP or the IMS Database editors.

•

You no longer receive a REXX error when recompiling a component from a baseline.

AppMaster Builder
Back to the list
•

A new checkbox, "Use File Tailoring for Dataview generation", has now been added to the Database
View dialog box in the AppMaster Builder (AMB) preferences. When checked, the Database Views will
be generated using File Tailoring files and the AMB Builder Server.
2820090 (1099354)

Communications Server
Back to the list
•

A new option, [Operation] synchronous=yes (or 1, or Yes, or y or Y) is now supported in the
Fileshare listener configuration.

Data Tools
Back to the list
•
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•
•
•

The editor no longer allows you to open a file if the file size (without header size) is not a multiple of the
record size on disk; an error is produced instead.
The editor no longer allows you to open a file if the file size without header size is not a multiple of the
record size on disk; an error is produced instead.
The level numbers displayed in a record layout correspond to the levels used in the .idy file that was
used when the structure file was created.

Editor Writing Assistance
Back to the list
•

IntelliSense (Visual Studio) or Content Assist (Eclipse) suggestions are no longer offered if you start
typing numbers and automatic triggering of suggestions is enabled.

Enterprise Server
Back to the list
•

•

In situations where the crossregion option of the shareoptions parameter is either 1 or 2, both a CICS
and a JCL job could have the same file open for IO. This has been fixed. In addition, the '-oo' (and the
synonymous '-o ') option of the casfile command has been deprecated. If '-oo' is used, you will now
receive a return code 4 (warning). Instead of '-oo', you need to use the '-ooi' option (open immediate). If
-oo is used with a region configured for VSAM shareoption use, the '-ooi' option is now forced.
2839272 (1101672)
When using an external security manager to secure a region, the EXEC CICS START TRANSID API
now works as expected and honors the USERID option. Previously, the started transaction would run
under the authority of the user that executed the EXEC CICS START API.
2835112 (1101201)

IBM Language Environment for OS/390 & VM Support
Back to the list
•

When calling SETENV, SYSOUT(?) can be specified. This designates the file as a spool file but will not
update its CLASS.
2841220 (1101955)

IDE
Back to the list
•

•

When compiling to multiple executables from the command line, you must specify the -logger parameter
to enable the correct log to be output to the console.
2848855 (1102932)
For a file added to a JVM COBOL project by adding the folder that stores the file (using the Source tab
on the Micro Focus > JVM Build Path > Source page in the projects' properties), there is now a new
context-menu command, Copy to Output Directory, in COBOL Explorer. Choosing this command on a
file triggers a build of the project and copies the file into the output directory.
2699374 (1094326)

JCL Support
Back to the list
•

The return code from a JCL printer exit will now be checked. If it is non-zero, the dataset that was sent
to the printer exit will be moved to the OUT-HOLD queue rather than to the PRINTED queue. To release
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the dataset, click "Release" in the ESMAC view - this will also present the dataset again to the printer
exit.
•

•

•

2834206 (1101079)
Under Enterprise Server, flushing an active job previously resulted in all associated spool records for
the job being deleted, but left the job running. A subsequent attempt to kill the running job using casout/
seeout failed due to the job spool record no longer existing. This change causes the flush request to fail
if the job is active. You must kill the active job first before attempting to flush it.
The catalog search facility has been enhanced to provide a quicker return when using wildcards in the
dataset name selection.
2698700 (1094266)
REXX can now be executed in VSE via IKJEFT01 and IRXJCL using in-stream data.
2831984 (1100883)

Run-Time System
Back to the list
•

The Audit Manager contains a new TIMEOUT option. When a client sends an audit event using the
‘CBL_AUDIT_EVENT’ API, the event gets placed in the next available slot in a shared memory block. If
shared memory is full (i.e. no slots are available), the event is re-tried until a slot becomes available.
If no Audit Manager is running, no events are removed from shared memory, and no slots will ever
become available. Therefore, use the new TIMEOUT option so that a client will only retry sending until
the TIMEOUT duration is reached; after which, it will stop sending audit events. If Audit Manager is
recycled, events will start to be sent again.
To set the TIMEOUT for all Audit Manager clients, specify the following line in the Audit Manager
configuration file:
mfaudit.timeout = n
Where n is the timeout value in milliseconds.
To set the TIMEOUT for an individual Audit Manager client, use the
‘CBL_AUDIT_CONFIG_PROPERTY_SET’ API. It takes an integer property-value, which should be the
timeout value in milliseconds.
If TIMEOUT is set using both methods, the client property TIMEOUT takes precedence, unless this
property is set to zero; in such cases, the TIMEOUT in the configuration file is used. If you use the
‘CBL_AUDIT_CONFIG_PROPERTY_GET’ API on the ‘TIMEOUT’ property, it only returns the
TIMEOUT value for the client property; it does not return the value set in the configuration file.

•

2838689 (1101685)
Several changes have been made to the implementation of IS DBCS, IS KANJI and IS JAPANESE
class condition tests:
•

IS [NOT] DBCS

•

When CHARSET"EBCDIC" is in effect, the IS DBCS test returns true when each character in the
string is deemed to be a valid DBCS character. A valid character has its first byte in the range 0x41
through 0xFE, and the second byte in the range 0x41 through 0xFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the DBCS test uses an OS call to determine if
the string contains only valid double-byte character, and returns true if valid.
IS [NOT] KANJI
When CHARSET"EBCDIC" is in effect, the IS KANJI test returns true when each character in the
string is deemed to be a valid Kanji character. A valid character has its first byte in the range 0x41
through 0x7F, and the second byte in the range 0x41 through 0xFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the IS KANJI test uses an OS call to determine
if the string contains only valid Kanji character, and returns true if valid.
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•

IS [NOT] JAPANESE
When CHARSET"EBCDIC" is in effect, the IS JAPANESE test is not supported, and will generate a
COBCH1806 Feature not supported in selected charset message on compilation.
When CHARSET"ASCII" is in effect, the IS JAPANESE test returns true when the string contains
only double-byte Japanese characters or single-byte Japanese Katakana characters, and returns
true if valid. When NSYMBOL"NATIONAL" is in effect, these class tests are not supported, and will
generate a COBCH0303 Operand has wrong data-type message on compilation.

2812895 (1098401)
SQL: OpenESQL
Back to the list
•

The DB2 CONCAT function and operator now convert to SQL Server using the HCOSS-supplied
dbo.CONCAT for character, numeric and datetime data. If you are using BINARY or VARBINARY data,
you must apply the HCOSS-supplied dbo.CONCAT_BINARY function. HCOSS applications deployed
with earlier versions of Enterprise Developer are affected, if they use string or binary concatenation. The
mainframe dialect DB2 || operator and CONCAT function now call a new SQL Server scalar function
dbo.CONCAT(). All existing programs with dialect=mainframe that use DB2 concatenation syntax should
be recompiled. All existing SQL Server databases that are accessed by these programs must have
dbo.CONCAT installed. To create the new function in your application’s SQL Server database, you can
either:
•
•

Run a DSN bind against the customer database. Or:
Execute the %ALLUSERSPROFILE%\Micro Focus\Enterprise Developer\hcoss
\InstallDigitsFunction.sql script.

This is a one-time only change to the database.
2843818 (1102248)
SQL Option for DB2
Back to the list
•

Spurious errors were sometimes returned while querying using an ALIAS.
2830383 (1100609)

Significant Changes in Behavior or Usage

| 17

Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.
In addition, note the following:
Application Workflow Manager
•

•

In an Application Workflow Manager modelled action, you retrieve a file from the remote zOS system
directly into a COBOL project, you must set the text file encoding of the COBOL project to UTF-8 in the
project properties in order for the Compiler to correctly process the source code. To set the encoding, in
the project properties of the COBOL project and on the Micro Focus > Project Settings > COBOL,
specify the source-encoding(utf8) Compiler directive in the Additional directives field.
Sequential MVS files are not locked when opened from zExplorer or from an AWM model using the Edit
MVS File tool from the MVS function package. This means sequential MVS files can be opened in
parallel in write mode and could be mutually overwritten.

Debugging
•

•

When debugging a remote program, the performance of the network, specifically the latency between
the local and remote machines, will have an effect on the responsiveness of Eclipse. Whenever Eclipse
has to show the new execution position, a number of messages are sent from the remote machine, over
the network, to get the required information. The effect of this is that it can take a few seconds after a
Step command is issued before Eclipse has updated the screen and is ready for the next command.
You can mitigate this delay by closing any unnecessary debug views. For instance, by closing the
Expressions view and the Variables view, the number of messages that are sent is reduced, which
allows Eclipse to update quicker.
Large programs can suffer from a large delay the first time that the program is displayed in the debugger
and an expression is evaluated. You can reduce this delay by following these steps:
1. Create a text file called debugconfig.xml.
2. Add the following lines, and then save the file:

•

<?xml version="1.0" encoding="utf-8" ?>
<NativeDebuggerOptions>
<DebugOption Option="REMOTECHECKER" Value="yes"/>
</NativeDebuggerOptions>
3. At a command or shell prompt, set the environment variable DEBUG_CONFIG to the full path name
for debugconfig.xml.
4. Start Eclipse from the same command or shell prompt.
Remote debugging does not work for programs running on AIX or HP machines, if you are trying to
debug using Enterprise Developer installed on a Linux machine.

Documentation
•

A known issue in JRE 1.7.0_45 (issue JDK-8028111) causes problems with searching and indexing the
help in the Eclipse help viewer if you are running Eclipse on a machine that has this version of JRE
installed.

Database Access
•
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If you have a remote COBOL project under Eclipse that uses DB2 ECM in Visual COBOL or HCO for
DB2 LUW in Enterprise Developer and the DB2 software is not installed on the client machine where

you are using the Eclipse IDE, you receive background parsing errors in your application. To resolve the
issue, you can do either one of the following:
•
•

Disable background parsing Window > Preferences > Micro Focus > COBOL > Editor and
disabling the checkbox for Background parsing.
Install the IBM DB2 client-side software on the machine on which you are running Eclipse. Go to the
IBM Support Home and locate the page entitled "IBM Download Fix Packs for IBM Data Server
Client Packages" .

Enterprise Server
•
•

•

The Historical Statistics Facility may generate incorrect records for SSTM-enabled enterprise servers.
On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server
Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.
In Enterprise Developer 2.3, some job scheduling tools from third-party vendors might stop
communicating with Enterprise Server. This might have an impact on our external partners who
integrate with Enterprise Server such as job schedulers which do not use MFBSI. The issue might occur
with job schedulers such as Zena, CA, ASG or UC4, if these are run outside of a COBOL environment
with the path set. Click here for more information about the issue and how to work around it.

IDE
•

If you are upgrading your license from Enterprise Developer for Eclipse Personal Edition (v2.2 or earlier)
to Enterprise Developer, or from Enterprise Developer Connect (v2.2.1 or later) to Enterprise
Developer, any existing projects compiled to either .exe or .dll files using the old license must be
updated in order to recreate the .cobolBuild file. You can do this done by adding or removing files
from the project or by deleting the .cobolBuild file. Updating the project in this way ensures Eclipse
will fully build the executable files.

Micro Focus Rumba
•

On versions of Windows Vista and later, Enterprise Server listens only on the IPv4 loopback address
(127.0.0.1). As a result, an attempt to connect to localhost with a TN3270 emulator such as Micro Focus
Rumba may fail. To work around this issue, in your emulator's configuration use 127.0.0.1 in preference
to localhost or your host machine's name.

PL/I Support
•

•

•

The Micro Focus PL/I Macro Preprocessor supports the majority of the IBM PP(MACRO) functions. The
only support for PP(PLX) is for the deprecated KEYS option. There are no plans to further extend the
existing support for PLX.
On SUSE, the PL/I CodeWatch debugger does not display output with MicroFocus ViewNowX. To
resolve this issue, you need to install a HotFix of ViewNowX - contact Micro Focus SupportLine for more
details.
Trying to debug remote PL/I projects that compile to 32-bit using the CodeWatch debugger fails. To work
around this issue, you must set the environment variable $COBMODE to COBMODE=32 on the remote
machine before you start the RDO daemon.

Resource Adapters
•

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need
to undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying
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using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).
REST/JSON IMTK implementation and the same-origin policy (SOP)
•

HTTP requests sent from scripts within a web browser to REST services deployed on an enterprise
server might fail due to the same-origin policy (SOP). Some browsers might implement (or support
plugins that implement) techniques for relaxing SOP such as cross-origin resource sharing (CORS) that
enable sending cross-origin requests successfully. For REST services, Enterprise Server does not
implement a method for relaxing SOP. This means that browsers that implement CORS (or any other
SOP relaxation technique) might still forbid requests made from scripts due to Enterprise Server not
implementing the equivalent technique on the server side.

z/Server
•

IBM's PTF UA75804 causes ISPF dialogs in a user server to stop working. If you have this PTF
installed, contact Micro Focus SupportLine to obtain a fix for this issue.
-2814867 (1098663)
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Adis
Application Workflow Modeller
AppMaster Builder
Assembler Support
Character Animator
CICS BMS Compiler
CICS Support
Code Analysis
Common Communications Interface
Communications Server
Compiler
Data Tools
Debugging
Documentation
Editor Writing Assistance
Enterprise Server
File Handling
IBM Language Environment for OS/390 & VM Support
IDE
IMS Support
Integrated Preprocessor
Interface Mapping Toolkit
JCL Support
Mainframe Access
MFIO
Micro Focus Common Client
Micro Focus Directory Server
Monitoring and Management
PL/I Support
Run-Time System
SQL: COBSQL
SQL: HCO for DB2 LUW
SQL: HCO for SQL Server
SQL: OpenESQL
SQL Option for DB2
XML Support
z/Server

Adis
Back to the list
•

Deleting a DBCS character no longer causes corruption when the ADISCF options 15 Pre Clear and 29
Read Screen are specified.
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2848637 (1102857)
Application Workflow Modeller
Back to the list
•

Creating filters from AWM elements now correctly populates "Create Filter" dialog fields.

•

2832662 (1100921)
An "ConcurrentModificationException" error when working with Eclipse projects in the Team Developer
views has been fixed.

•

•
•
•

2840464 (1102342)
A potential integrity issue where it was possible to change the editor context by a global editor action
has been fixed. As this could have an unexpected effect on Edit or Close actions in the same edit
scenario, a new attribute "Update Edit Context" was defined in the Global Editor Actions relationship
which controls whether the edit context can be overwritten or not. By default, this attribute has the value
False. This means that if a Global Editor Action is to be able to overwrite the edit context, this attribute
has to be set to True.
The 'Update Edit Context' attribute has been added to the Global Action is an Editor Action.
The wizard IDs used in the project models have been added to the Open Wizard tool of the Eclipse
function package.
Default z/Explorer file mappings have been added for the most common z/OS naming conventions.

AppMaster Builder
Back to the list
•

•

2853002 (1103445)
An issue with uninitialized variables resulted in some garbage characters being written to the .lst file. As
a result, the generation used to fail.

•

2849839 (1103017)
You no longer receive multiple completion messages in the console about the same program.

•

2845473 (1102772)
This release now includes a 'User Variable' feature.

•

2844430 (1102543)
S-COBOL folders are now only created when appropriate.

•

2838957 (1103164)
An invalid logic was being included during job submission for a program generate.

•

•
•
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Previously, when the DDISYMB folder was empty during the dialog initialization, the dataView Name
that was to be built did not get updated once an "Add" was performed. This could be confusing because
you could load the source members but received some errors when trying to perform a build as a result
of the dataView Name being blank. A check is now performed about whether the DataView Name is
empty and, if it is, the dataView Name is set to the first tree entry. The dialog is then reloaded.
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2824666 (1100931)
AppMaster Builder now performs a check to verify whether the names of new COBOL projects are
updated in both the preferences and in the application's properties files.
2823442 (1103178)
An issue where it was not possible to hide the line numbers in columns 1 to 7 has been resolved.
2814378 (1098685)
An issue where using projects that resided in directories with long and spacey paths resulted in errors in
Dataview generation for a SQL target has been resolved.

•

An issue that was causing the editor to loop has been fixed.
2840350 (1101882)

•

Correct use of the REM keyword entered in column 4 no longer hangs the system.

•

2851451 (1103211)
The UI Interface list now offers the 'MVS' option.

•

2850872 (1103180)
In some scenarios, AppMaster Builder defaulted to opening all programs in Online Express, even when
a given program was originally created in the Program Painter.

•

2845106 (1102561)
The Usermacs member syntax is now parsed correctly.

•

2836718 (1101394)
The AMB Plugin Editor would sometimes hang when expanding an application.

•

2829386 (1101895)
The property settings in the Database View are now retained when switching workspaces.

•

•

2828834 (1102286)
A problem with showing multiple console views during generation has been fixed as follows: o All output
from AMB generation goes to the AppMaster Builder Console view o Any output from a Micro Focus
Build COBOL compilation goes to the COBOL Console o Both the AppMaster Builder and the COBOL
Consoles stay visible throughout, showing messages specific to their respective Console types
2823482 (1099825)
When switching to a different workspace in Eclipse, AppMaster Builder project data was not updated to
reflect the projects in the new current workspace.

•

2823395 (1100637)
The behavior of the Rename action on the Dataview Explorer tab has been modified as follows: 1) New
names are now limited to eight characters. 2) Changing the Source folder resets the Selected item in
the list. 3) When renaming a SQLSCHEM member, its contents are now modified to correct the
"CREATE SUBSCHEMA" statement and to reflect the new name.
Application edits now support hyphens in the paragraph names.
If a VSAM DDISRC member only contained one keyword, "DDI SUB", this keyword was not displayed in
the drop-down list showing the available members.
The COBOL project list no longer displays duplicate project names.

•

Screens saved in the screen painter no longer corrupt the APSSCRN file.

•

•
•

2844771 (1102405)
Assembler Support
Back to the list
•

The DCB macro requires the DSORG= parameter in order to be more compatible with the mainframe.
This parameter has now been added to the Assembler sample programs PGASM04.mlc and
qsamex4.mlc in the Mainframe\Assembler\Classic\QSAM directory in the installation location of the
samples so that these files now assemble without any errors.

Character Animator
Back to the list
•

Breakpoints set on paragraphs or sections can now be unset.
2845763 (1102710)
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•

Breakpoints are saved correctly when Animator is detached.

•

2842488 (1102878)
Failure to detach the Animator from a process no longer results in the breakpoints being lost.
2842488 (1102117)

CICS BMS Compiler
Back to the list
•

A new menu item, Customize IDE, on the Options menu of the BMS Painter utility enables you to
specify your preferences for a font face and font size of the text within the BMS Screen Painter and in
the Output window.
2835960 (1101266)

CICS Support
Back to the list
•

•

•

•

Some issues in COBOL Web services and CICS COMMAREA-based web service environments when
EXCI was involved have been fixed. Previously, an ADPL abend was issued when a CICS program
executed an EXEC CICS SYNCPOINT in a CICS COMMAREA-based web service environment. This
has been fixed.
2848968 (1103075)
When using ISC, ADPL could abend and the client terminated the transaction after changes introduced
by CWS work for LINK without SYNCONRETURN. Enterprise Server now allows the commit to take
place when it receives the end of a conversation and when dfhzcsmi is issuing the commit.
2848069 (617536)
When ES_XA_RECONNECT is set to true and a number of retries is defined for
ES_XA_nnnn_NB_RETRIES (where nnnn is the XAID), the number of retries was not being checked,
and the XA switch was disabled immediately after a connection issue occurred. The value defined in
ES_XA_nnnn_NB_RETRIES is now honored and, when a connection issue occurs, the switch is not
disabled until after the connection has been attempted for the number of retries.
2843692 (1102209)
Previously, the product did not identify PL/I programs as such and defaulted to ASCII. PL/I program are
now correctly identified as such and use the API-CODESET value that has been set by PL/I in the
CICS-API control block.
2841424 (1102109)

•

An ENQ taken for a write-lock when writing to a recoverable TQD was not released at the end of a task.

•

2849271 (1102960)
When you start a region, there is no longer a delay of one second per printer when the printers are
installed.

•

2847778 (1102784)
CASPRT now calls the casmguex exit so that the CASCL0020I message can be suppressed from the
console.log file.

•

2847778 (1102785)
A problem in the dfhgglbl module when a SPOOL process was active could cause a CICS process
cassplcp to fail to start with a run-time system error 114.

•

2840334 (1101859)
PL/I applications no longer abend on the second and any subsequent invocations when the "Force
Phase In" setting is set to "off". This occurred on all supported UNIX and Linux platforms.
2834015 (1101058)
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•
•

•

•

Previously, the PROTECT option was not recognized when using START/PROTECT with TRANCLASS.
2832905 (1100929)
When using mirror transactions, if a resource has browse placeholders or is recoverable, or the lock has
been acquired, a mirror transaction becomes a long-running mirror and does not end until the issuing
transaction ends the logical unit of work - on SYNCPOINT or RETURN. Any resources that the mirror
has acquired are freed when the initiating transaction issues the appropriate command to free them.
Previously, mirror transactions were only released on RETURN. They are now also released on
SYNCPOINT.
2829652 (1100859)
When installing a terminal that was not in use, an incorrect flag was checked. An error message
"CASRD0025E 3270 Terminal entry xxxx is out of service or it is in use" was displayed.
2821671 (1099558)
Previously, when using TRANCLASS, if a TSQ was deleted in one thread while another thread was
trying to read the queue at the same time, Enterprise Server returned an ITEMERR error instead of
QIDERR because the queue had been deleted.
2819309 (1099471)

•

•

A problem adding a new startup group on the casrdo97 startup list ESMAC page immediately after
deleting a group on the same page has now been corrected.
2850524 (1103106)
When sending a response back, the product now escapes any HTML sensitive characters in order to
avoid an XSS scripting vulnerability.
2846631 (1102678)

•

The behavior of non-facility transactions was too silent. Messages are now being sent to the console
about transaction attach failures. The message KC0041 is now sent to the console for asra abends.
2845530 (1102445)

•

•

Performing a phasein on an active program could corrupt the local storage chain for the SEP which was
running that program. A Run-Time System error could occur.
2846132 (1102972)
The casfile -ooi option failed with an RTS114 error when opening a CICS FCT of the Alt Index type.
2845760 (1102598)

Code Analysis
Back to the list
•
•

The GO TO statement in the analysis result now has a valid sequence line.
Handling for TRY-CATCH-FINALLY code block has been implemented. An issue with Level 78 constant
declared in linkage section has been fixed.

Common Communications Interface
Back to the list
•

•

The performance of Fileshare servers on Linux and UNIX platforms has been substantially improved
since the 2.2 Update 2 and 2.3 releases of Visual COBOL and Enterprise Developer.
2829622 (1101067)
On UNIX, the product previously was looking for the cciusers.dat file (used for the initial population of
the MFDS Internal Security users and groups) in the /etc/ folder. Starting with this release, the
cciusers.dat file in $COBDIR/etc/ is used in preference. This removes the requirement to store
cciusers.dat in the /etc directory.
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•

Components that use the SSL/TLS support in CCI, such as Fileshare and MFDASMX, can now use
private key files in binary (DER) format.

Communications Server
Back to the list
•

The Enterprise Server EZ Sockets feature no longer fails to initialize at system startup if the MFCS
connection to MFDS is unusually delayed.
2847439 (1102743)

Compiler
Back to the list
•

The expression 'instance of type com.microfocus.cobol.program.Reference' (or the .NET equivalent) no
longer produces unverifiable code in either JVM COBOL or .NET COBOL.

•

2844614 (1102378)
OSVS report writer programs now compile as expected.

•

2848192 (1102831)
SQL programs containing procedural $SET CONSTANT directives now compile as expected.

•

•

2847029 (1102768)
Passing variable length groups to a user defined function now produces correct object code, which
executes as expected.
2845100 (1102408)
An implicit definition of a VALUE OF FILE-ID, that is, when the program does not declare the data-name
specified in the VALUE OF FILE-ID clause, has been fixed. Previously, the implicit definition was being
made external when it should not have been.

•

2844151 (1102278)
COPY statements that span multiple lines no longer stop REPLACE operations from working as
expected.

•

2843367 (1102672)
A REPLACE statement that acts upon a literal containing a continuation character, where the literal also
contains quotation marks that start and end on different lines, now compiles as expected.

•

2841444 (1102573)
COPY REPLACING now correctly affects a REPLACE statement, even if a REPLACE statement is
already active.

•

2841281 (1101930)
COBOL applications using ActiveX controls need to add the -A option to the OOCTRL Compiler
directive in order to invoke methods in the ActiveX control.

•

2840671 (1101874)
In the execution of an XML GENERATE statement, the '&' character is now replaced as expected, even
when the associated field is numeric.

•

2839493 (1101911)
Warning message "COBCH0990W No period following EXEC SQL INCLUDE END-EXEC. DB2
coprocessor will fail" is now restricted to mainframe dialects only.

•

2833943 (1101053)
Alphanumeric ACCEPT statements that specify the CONVERT phrase, under RM(ANSI), now work as
expected.
2833548 (1100998)
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•

•

A DBCS name specified as an EXTERNAL ASSIGN name in a SELECT statement is now processed as
expected.
2833547 (1100996)
A DISPLAY of a national literal now executes as expected.

•

2833546 (1100995)
A DISPLAY of the result of the DISPLAY-OF intrinsic function with a national literal argument now
executes as expected.

•

2833544 (1100994)
The HOSTRW directive no longer truncates Report Writer files when there is no RECORD CONTAINS
clause in the FD for the report file.

•

2826147 (1100638)
An EXEC CICS statement that references a non-unique paragraph name (but unique within that
section) now compiles as expected.

•

2816510 (1098877)
A program compiled with a mainframe dialect that contains a source line with non-ASCII characters in
Area C no longer incorrectly receives the flag message "COBCH1082S Source line is too long".

•

2809384 (1097885)
An ALTER statement on a paragraph defined in a previous section, which also had an ALTER statement
on that paragraph name, now executes as expected.

•

•

•
•

•
•
•

•

•

2514516 (1079210)
The informational message "COBCH1210 COMP processed as DISPLAY (future occurrences not
indicated)" has been fixed so that it is produced based on the COMP directive setting and not the
DIALECT setting.
A COBRT114 error in generated code on Itanium platforms, for extremely large programs (> 2^24 bytes)
has been fixed.
2844642 (1102395)
A link error "fatal error LNK1190" when compiling to an executable on 64 bit Windows no longer occurs.
2843600 (1102215)
A bug in generated code on Intel-x86 32-bit platforms, when generated with opt (4), which caused an
infinite loop, has been fixed. The bug affected SORT on a table that has an "occurs ... depending on ..."
clause.
A bug during compilation with the OPT(3) directive set, where a loop variable could contain an incorrect
value after a PERFORM UNTIL loop, has been fixed.
An error no longer occurs as the result of using the 'AS template-1' phrase within an INVOKE
statement. Previously, this could generate a COBRT240 runtime error.
On little-endian 64-bit platforms, such as Windows 64-bit or Linux x86 64-bit, a bug could occur with the
following code: add 1 to var-a add 1 to var-a giving var-b where var-a is a comp or comp-x item less
than 8 bytes in size. The result of the bug was that the wrong value was stored in var-b. This bug has
been fixed.
While debugging using previous versions, an exception occurring in a program using copy files could
lead to the debugger showing an arbitrary position in one of the copy files.
2825779 (1100297)
A compile time error when compiling to JVM bytecode, and where $CLASSPATH is longer than 4096
characters, has been fixed.

Data Tools
Back to the list
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•
•
•
•
•

When filtering records, it is based on the selected encoding when the Filter dialog box was opened.
Previously, the filter was only using ANSI encoding.
The editing caret no longer disappears when in Edit mode.
The Hex View is now displayed when you click Toggle Hex after opening a data file that does not
contain a layout.
Deleting the last record in a sequential fixed-block file or a line sequential file no longer produces an
error message or crashes the editor.
When copying and pasting records, the record length for fixed block files is no longer resized.
2833640 (1101732)

Debugging
Back to the list
•

•

The handling of NLS, Japanese and multi-byte character sequences has been improved, when
animating programs on UNIX.
2836278 (1101545)
On Windows, the CBL_DEBUG_START routine will now use the COBANIMSRV environment variable
as the identifier, if the identifier passed in is NULL. This also means that cross-session animation now
works as per the UNIX environment.

Documentation
Back to the list
•

The documentation has been updated to include the "ra.xml file" topic describing the contents of the
ra.xml file, which includes a list of properties that configure your CICS resource adapter.

•

2828775 (1101075)
The topic "DEFINE CLUSTER" in the product help has updated information about the RECORDSIZE
parameter and the file that will be created.

•

2830878 (1100668)
Dead Code Analysis is not supported for remote COBOL projects. Clarification of this restriction has
been added to the documentation.

•

2814273 (1098595)
When handling XML files, after a successful WRITE action, the size of the XML file written is returned
as the status code.

•

•

2587541 (1085484)
When using Fileshare with the CCISM protocol, ensure the server is started using the /SC switch. This
switch starts Fileshare in synchronous communications mode, which gives better performance than
when using Fileshare with the CCITCP protocol. Without this switch, Fileshare operations may be
slower.
An Enterprise Server error message has been added to the help pages for CASKC0048, process softkilled failed and was hard-killed.

•

2846350 (1102574)
The ldpli topics have been updated to include information about native ld options.

•

2840325 (1101829)
The product help now provides the correct definition of the ES_ESM_RESSEC environment variable.

•

2836105 (1101281)
libmf.so has been renamed to libmfpli.so/libmfpliz.so in the Open PL/I User's Guide.
2822746 (1099744)
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•

The "mfsupport" utility is now correctly named and spelled as MFSupportInfo, for Windows platforms.

•

2848869 (1102896)
In the topic "Sample Parameters File", the value of Keys towards the end of the code sample has been
changed from 48 to 60.

•
•

•

•

•

2844479 (1102300)
The parameter TSOE_JOBPREFIX has been replaced with TSOE_JOBCHAR.
2844210 (1102719)
Additional information added to the help pages for the audit event codes emitted by the External
Security Facility (ESF) and Micro Focus Directory Server (MFDS).
2842807 (1102120)
If you receive a 9/064 file status, this is informing you that a process has attempted to open a file using
a different locking mode than the one that is already in place. The locking mode is determined by the
tunable strict_file_locking. All processes accessing the same file need to be using the same locking
mode; that is, all have the tunable set to the same value, which can be either 'true' or 'false'.
2837405 (1101440)
The instructions in the "Tutorial: Remote mainframe development" have been updated with information
about how to pre-allocate a mainframe dataset before transferring the sample XMIT file to the
mainframe.
2809528 (1100934)
The product documentation has been updated to include the topic "IMS and GSAM Databases" located
in the table of contents under Programming > IMS Support.
2789025 (608922)

•

Option D(o) in the Character Animator is only applicable when you are debugging intermediate (.int)
code.
2839572 (1101835)

Editor Writing Assistance
Back to the list
•
•
•

•

•
•
•
•
•

IntelliSense (in Visual Studio) and Content Assist (Eclipse) no longer offer verbs within EXEC blocks.
The END-EXEC statement is offered instead.
The IntelliSense suggestions now include the attributes for any reference, output or returning
parameters that are explicitly declared in the linkage section.
An issue where IntelliSense (Visual Studio) and Content Assist (Eclipse) offered Sort/Merge items
where only file items were valid has been resolved.
(616206)
Intellisense (Visual Studio) and Content Assist (Eclipse) now only offer suggestions for types which are
suitable to the context. For example, the suggestions for a CATCH phrase only include exception types
and the suggestions after NEW only include constructable types.
Intellisense (Visual Studio) and Content Assist (Eclipse) now offer members of the current type when
there is no qualification using "SELF::" or "SUPER::".
Intellisense (Visual Studio) and Content Assist (Eclipse) now offer suggestions for READY TRACE and
RESET TRACE.
The Intellisense (Visual Studio) and Content Assist (Eclipse) suggestions no longer include multiple
imported types with the same short names.
IntelliSense (Visual Studio) and Content Assist (Eclipse) now offer suggestions for specifying array
types (OCCURS) in managed COBOL.
IntelliSense (Visual Studio) and Content Assist (Eclipse) now offer all relevant data for EXHIBIT
statements.
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•
•
•
•

IntelliSense (in Visual Studio) and Content Assist (in Eclipse) now correctly handle the automatic import
of the namespace (and any nested types) from the current type.
Condition-value items are now correctly accepted as complete conditional expressions.
IntelliSense (Visual Studio) and Content Assist (Eclipse) no longer offer completion suggestions outside
of their proper scope.
IntelliSense proposals now correctly replace unquoted copybook names in the editor.

Enterprise Server
Back to the list
•

•

•

•
•

•

•

•

•

•
•
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The caslock utility now validates the APPLID. In order for caslock to remove all locks for a given cluster
client, the passed APPLID must already be known to the GLM - for example, it must already have an
entry in the CASGLM.LCK file.
2847684 (1103145)
Cancelling a job sends a sigterm signal indicating that the process needs to terminate. If the process
did not complete, Enterprise Server would then send a sigterm again instead of sending a sigkill signal.
A sigkill signal is now correctly sent in such situations.
2845534 (1103261)
When processing a WSBIND that contain nested occurs levels, the group level is now correctly
maintained.
2844738 (1102697)
XA transactions will now end when an ECI request fails with PGMIDERR.
2843668 (1102276)
The order in which user privileges are checked when accessing cataloged files has changed. First, a
check for the alter privilege is performed. If access is denied, Enterprise Server performs a check for
update privileges. If this check fails as well, a final check for read access is performed. This is reflected
in both the console log output and in any Audit Manager events that are generated.
2842162 (1102048)
Previously, when generating a MQRFH2 header, the CCSID that was used was 0. This resulted in an
abend APIJ on the CPIL transaction and in an error 2111 on the MQGET API. The MQRFH2 header is
now generated with the correct CCSID values.
2841974 (1102004)
When the targetService option was enabled for the JMS Invoke Webservice, no response was returned
to the application if the URIMAP was not found. This caused the transaction to hang. A message is now
sent to the Dead Letter Queue, and the application fails with an error message DFHPI0112.
2841602 (1101959)
casspool type 16 records (spool-printed-88) are now being processed and the printed spool records get
deleted when using Delete from the ESMAC page.
2839657 (1101706)
Mainframe Subsystem support for the EZ Sockets APIs in Enterprise Server now includes the
SO_RCVTIMEO and SO_SNDTIMEO socket options. Support for these is limited to the options
provided by the underlying Operating System.
2833375 (1101002)
A Run-Time System error 114 no longer occurs when a GET request is received.
2825851 (1100157)
You can now start Enterprise Server instances that have the casuesm exit enabled. If you are already
using this exit, you must recompile your applications using the updated cascbesm.cpy that is in the
cpylib subfolder in the product installation directory. You also need to include the version check at
initialization time that is implemented in the skeleton casuesm.cbl file that is in the src in the product
installation directory.

•
•

2821228 (1099658)
You no longer receive a memory leak in cassi processes when using the Micro Focus External Call
Interface.
If no license has been found when starting Enterprise Server, Enterprise Server Administration now
periodically checks whether a license server is present.
2836688 (1101388)

•

•

•
•

The Enterprise Server External Security Facility, using LDAP-based security, no longer incorrectly
matches a wildcard character ("*") in a resource access rule to a period (".") in the requested resource
name. The double wildcard sequence ("**") does match a period (".").
2854402 (1103604)
When using LDAP-based security immediately after installing Enterprise Server, with the sample access
rules provided with the product, the TRANCLASS definitions in ESMAC are now granted administrative
access to as it is for other resource types.
2838380 (1101547)
The LISTREFERENCES command now works correctly when the resource class names use special
characters.
When using a JES initiator in the GLM, the locks could not be released properly if a job was running in
that initiator while another process was waiting for the locks.
2838871 (1101612)

File Handling
Back to the list
•

•

•
•

OPEN EXTEND EXCLUSIVE for sequential files accessed via ACUFH/RMFM now correctly locks the
file.
2849233 (1102953)
If a program opens an RM/COBOL or ACUCOBOL-GT data file, and the file format has been specified
at compile time (and not in a run-time config file), then file assignments containing a sub-path will
correctly search locations specified by COBDATA.
2842825 (1102218)
Rebuild now correctly processes the key structure defined through an options file.
2837028 (1101412)
Relative filenames specified with dot-slash (e.g. ./file.dat) will now match filename tags in the extfh.cfg
configuration file (e.g. [file.dat]).
2832386 (1100932)

•

•

Rebuild option /t now supports extended ESDS (XESDS) files. Rebuild also allows you to create an
ESDS file without supplying the index key information (option /k).
2837756 (615857)
Rebuild now allows the case where "9" is specified after ":"
2836782 (1101437)

•

SEP corruption no longer occurs when running a SORT operation.

•

2843320 (1102182)
MFSORT now returns a 9/018 error when an incorrect record length is specified.

•

2834614 (1101131)
Sort operations on 64-bit UNIX platforms no longer produce a COBRT114 error if record size is bigger
than maximum non-key data portion held in memory.

Resolved Issues

| 31

IBM Language Environment for OS/390 & VM Support
Back to the list
•

The Language Environment jobs which are run after an abend now runs correctly.

•

2847262 (1102897)
A problem with multiple calls to MFLEINIT without subsequent process termination causing exhaustion
of virtual file space has been corrected.
2829308 (1101231)

IDE
Back to the list
•

Find References now works in PL/I programs that do not have options(main) attribute specified.

•

2849669 (1103004)
Builtin PL/I functions are no longer reported as unused when explicitly declared and used in a program.

•

•

2849349 (1102975)
Debugging of remote application attachments now respects the order of source containers during
source lookup instead of relying on the information in the IDY files.
2845910 (1102501)
Error annotations that follow INCLUDE statements are now displayed on correct lines.

•

2845634 (1102720)
The editor Outline view and content assist information was sometimes empty for PL/I and JCL files in
remote linked folders.

•

2845568 (1102958)
Opening a PL/I file in the Micro Focus editor could display an error if another Eclipse plugin also defined
a PL/I content type.

•

2845381 (1102869)
The 'delimited' and 'delimited by size' COBOL program clauses no longer prevents the Outline view and
Content Assist from functioning correctly.

•

2843597 (1102236)
Each project now has its own build console that accumulates build output until explicitly cleared or
closed by the user.

•

2841821 (1102009)
Limited support has been added to allow PL/I macros to be expanded when being parsed by the editor
rather than just being ignored.

•

2840874 (1101878)
Mainframe datasets can be accessed through SourceConnect.

•

2840705 (1102022)
Added new system property build.errors.limit which limits the maximum number of problem error
markers created as part of a build. You can modify this property by editing the eclipse.ini file.

•

2840702 (1101870)
Limited support has been added to allow PL/I macros to be expanded when being parsed by the editor
rather than just being ignored.

•

2837026 (1101413)
A momentary loss of network connectivity can result in COBOL Project settings being lost if the project
was stored on a network location.
2833101 (1101082)

32

| Resolved Issues

•

•
•

When debugging native COBOL applications the .idy file loaded by the debugger is now used to create
the editor's Outline view and other information such as content assist and colourization.
2827035 (1101229)
A full rebuild of all projects in a workspace could sometimes be triggered after restarting Eclipse.
2816310 (1101363)
Debugging network file system remote projects can be made faster by using the 'Remote File System
Directory' container to specify the source lookup path on the Source tab of the Debug launch
configuration.

•

2792882 (1096491)
By selecting the "Create top-level folder" option when importing the copybooks and then adding the
folder to the Dependency Paths/Copybooks, the project will compile successfully.

•

2682665 (1092789)
It is now possible to change the compiler directives in the project settings without cleaning the build
artifacts through the use of a new preference.
2647695 (1089794)

IMS Support
Back to the list
•

The IMS database editor could not access a database directly. The editor was only functional when
editing a database using a PCB in a PSB.

•

2849835 (1103025)
Direct access to a secondary index database that uses system generated /SX fields no longer fails
when the primary database is compiled using the SXRBAFORMAT"2" directive.

•

2845024 (1102464)
Read only access to an IMS database from a batch application failed after IMS DB had performed an
automatic backward recovery. Restarting the server corrected this condition.

•

2844983 (1102431)
A BMP program using a PSB that specified CMPAT=NO sometimes returned incorrect results to a DB
call.

•

2844084 (1102463)
Batch IMS applications that access IMS database data directly can override ES_IMSDAT and access
this data in different folder locations.

•

•
•

2833328 (1100981)
A DBD from a DOS/VS environment that made use of an assumed START= parameter on the SEGM
FIELD statement was previously unsupported. This support requires the IBMPLATFORM=DOSVS
DBDGEN directive.
A protection fault resulted when attempting to load an IMS database using MFDAS when the ACB was
missing.
The Admin SEP no longer abends with an RTS 114 error when starting an MPR with an MPR name.
2845871 (1102500)

•
•

The attribute byte for a dynamic attribute was being improperly converted. This has been corrected.
2849654 (1103033)
The limit of labelled DFLDS and MFLDS has been increased from 500 to 1000 per MFS. This enables
you to use MOD 5 type of screens (24 X 132) which can contain many more fields than the more
common MOD 2 type of screens (24 X 80).
2849190 (1102943)
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•

•

•

•

•

The MFS generator has been updated to fix an issue with /FOR Type-5 screens. To apply this fix, you
must regenerate your MFS source files using this release of the product. Also, the device type specified
in the MFS for MOD 5 screens (27 X 132) must be 3270-A7.
2848896 (1102915)
MFS files with literals of the form "DFLD G'<dbcs characters>',POS=(03,1),LTH=54,ATTR=(PROT)"
were seeing the last byte of the literal clipped in the generated control block and on screen at run time.
This problem has been fixed and all G literals should generate and display correctly.
2848014 (1102773)
If the trancode is 8 bytes in length and the application does not accept a trailing space as part of the
input message, you must ensure that the trailing space flag is checked in the enterprise server
configuration. In addition, a fix has been made to IMS code that applies to conversational application
when the trancode is less than 8 bytes. When the conversation starts for the very first time, IMS now
strips the trancode out of the input message and puts it in the trancode area of the SPA buffer. The input
message is then shifted to the left by the length of the trancode. Afterwards, the input message is
formatted strictly by the MFS input definitions.
2837836 (1101690)
If the last output LPAGE is missing its COND statement, an error message is considered unnecessary
and is no longer issued. You will still receive an error, if the COND statement is missing from any output
LPAGE that is not the last.
2833816 (1101032)
The NULL FILL value in the input field (pfkey) is now correctly recognized and NULL FILL characters
are stripped out from the input message and the message is compressed. When the field following the
field (pfkey) with NULL fill characters is the trancode field, MFS now invokes the application associated
with the trancode. Katakana characters are not displayed correctly. To work around this issue, you need
to set PCOMM or RUMBA codeset 930 which is compatible with MFCODESET=9122.
2833225 (1100955)

•

The APARM returned to the AIBTDLI INQY ENVIRON call is now restored with each execution of the
INQY call.
2846411 (1102605)

•

•

A previous update had updated the behavior of a CHNG call issued from an OTMA- or IMS Connectsubmitted transaction such that the destination was assumed to be the OTMA client. In some
circumstances, the previous behavior of assuming a non-OMTA client is desirable. To use the previous
behavior, set the ES_IMS_BYPASS_OTMA_DEST_RES Enterprise Server environment variable to
ES_IMS_BYPASS_OTMA_DEST_RES=y.
2835781 (1101595)
For servers using external security, IMS printers sometimes failed to reconnect after disconnecting.
2835352 (1101479)

•

•

The IMS Database Utility could not load an IMS database when a special character such as "@", "#" or
"$" was used in the first position of the segment name definition (DBD SEGM NAME=).
2848521 (1102845)
On Red Hat Linux, incorrect results were returned to an EXECDLI application program. The WHERE
clause of a GET call was incorrectly negated.
2845172 (1102400)

Integrated Preprocessor
Back to the list
•
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| Resolved Issues

Programs with EXEC SQL INCLUDE statements that have a trailing period that is not immediately
following the END-EXEC now compile as expected with the COBSQL preprocessor.

•

2844222 (1102486)
A user preprocessor which calls directly the 'CP' system preprocessor now behaves as expected during
the syntax checking of source files you are editing.

Interface Mapping Toolkit
Back to the list
•
•

Ebiz execution no longer fails when tracing is enabled and several programs contain a mismatched
linkage offset.
JSON request messages containing multi-byte UTF8 characters caused errors for REST web services.

JCL Support
Back to the list
•

You no longer receive an RTS 173 error (program not found) when running mvscatpb on Linux UNIX
platforms.

•

2841338 (1102050)
MFDB2UNL did not process the SELECT statement correctly if it started in a column other than 1.

•

2845002 (1102407)
An issue that caused SSTM and JCL-enabled regions to hang when starting has been resolved.

•

2849994 (1103031)
IDCAMS ALTER now supports renaming of physical files if they have an environment variable specified
in their paths. To enable this behavior, you must set the environment variable MF_PCRENAME_LAX to
'Y'.

•

2848692 (1102898)
When assigning a new job number, records from past jobs with the same job number were erroneously
included in the job listing.

•

2847426 (1102709)
The spool housekeeping utility, mvssplhk, now does not delete active CICS SSTM jobs. It is possible to
remove expired SYSOUT datasets from the jobs.

•

2847421 (1102708)
It is now possible to include key offset and length information when replacing cataloged VSAM index
and data elements using MVSCATPB.

•

2846554 (1102608)
MVSSPLHK has been updated so you no longer receive a duplicate error when the CATALOG is
archived.

•

2846100 (1102623)
Using the MFCATXML or the MVSCATPB REPL function to replace a catalog no longer causes the
enterprise server to hang.

•

2846018 (1102524)
When loading catalog records from an XML file using MFCATXML, the pds extensions from earlier
records are no longer carried forward.

•

2845761 (1102519)
Quoted values are now supported for the PRTQUEUE OUTPUT statement.

•

2844696 (1102356)
Job outputs are now correctly being sent to the printer exit when there is a heavy JES workload.

•

2844053 (1102254)
The following DATACLAS parameters are now supported: AVREC/AVGREC, DSORG and RECORG.
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•

•
•

•

2842304 (1102044)
The MVSSPLHK housekeeping process now correctly removes JOB99999.
2842083 (1102018)
The Micro Focus emulation of ICETOOLS no longer incorrectly processes the RDW directive twice.
Previously, this would lead to lost data.
2841136 (1101894)
A JESYSMSG for a reprinted job now correctly displays in the JES Spool>Printed queue.

•

2840462 (1101867)
The change date in the catalog was not being updated for concatenated datasets. The catalog now
shows the time/date for the end of step processing for all concatenated datasets.

•

2840128 (1101779)
When the first job run uses 2 programs that both open the same file, the Shareoption Manager no
longer incorrectly returns an access denied message.

•

•

2839737 (1101834)
Where appropriate, LEX files are now correctly removed during the MVSSPLHK spool housekeeping
process. Previously, if the ES_ALLOC_OVERRIDE variable specified a different location to the
MFALLOC_LOC variable these files could be missed. Also, the message for casspool record type 16
records in SYSPRINT now displays correctly.
2839699 (1101778)
A SORT operation on a Variable Block file where INREC processes are specified no longer incorrectly
changes all records to Fixed Block.

•

2839561 (1101737)
The correct next bias number for GDGs will be used when existing biases are removed.

•

2837967 (1102225)
The casout /g<jobnum> command now works correctly when ES_JESYSMSG_OUTPUT=Y is set.

•

•
•

•

•

•
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2842497 (1102064)
A DD referback was incorrectly using the catalog properties of the file referred to and not just those
DCB parameters defined on the referred to DD card.

| Resolved Issues

2837860 (1101512)
The IDCAMS REPRO command generates a file status 35 if the physical file of a cataloged input file
does not exist.
2837596 (1101509)
A problem where incorrect HSF stats were being reported for the SSTM job has been corrected.
2837158 (1101448)
If a printer exit requests removal of the JESYSMSG (JCL Job log), any OUTPUT statement and
SUBSYS information is retained. If restart is enabled, the job log and other job files required for
restarting are not removed.
2836023 (1101573)
When copying SYSUT1 to SYSUT2 (using IEBGENER), where SYSUT2 is a spool file with no RECFM
supplied in the JCL, the SYSUT1 RECFM is now used if it is valid. Previously, it was only being used
when set to "F".
2834419 (1101200)
It is now possible to scroll backwards from the first spool display page to the last one. If the spool file is
rather big, however, scrolling could be slow as all the spool records need to be processed before the
last page is displayed. This is the expected behavior.
2833812 (1101030)
You no longer receive a file locked error when JCL accesses CICS shared files.

•
•

•
•

•

•

•
•

•

2833284 (1101010)
JCL validation no longer fails an OUTPUT statement that has no parameters.
2833175 (1100991)
An error in the JCL scanner that reported a JCL error when scanning a job that contained a NULL IF
statement has been corrected.
2832582 (1101015)
The JCL COND CODE for PRINTED queue records was displayed with invalid characters.
2831180 (1100784)
A problem that resulted in receiving an RTS 114 error when clicking on the REPLY button has been
fixed. This would happen if you were using dynamic debugging to debug a JCL job and clicked "Stop
Debugging" while the job was still waiting for an input from the user.
2828547 (1100819)
MVSSPLHK now scans the LEX file directory for orphan LEX files, and deletes them if they are older
than the max retain period.
2826722 (1100693)
Using DSNRLI with multiple XA switch modules and performing a 'SWITCH-TO' action to a XA resource
with a name shorter than the previous resource, caused an error with a return code of 4 and a reason
code X'00C12205'. The DSNRLI module now correctly performs 'SWITCH-TO' actions.
Enterprise Developer now provides a new utility, MFJPTPCH, that emulates the IEBPTPCH (PrintPunch) utility.
This release provides a new environment variable, MVSSPOOLDIR, which can be used to direct spool
control files to a location which is different to the location of the main catalog file.
2839703 (1101713)
It is now possible to configure multiple user catalogs for Enterprise Server.
2514366 (1101309)

•

The SETPARM statement can now be used with the IF statement. For example: SETPARM pppp=xxxx
IF pppp=xxxx
2820858 (1099472)

Mainframe Access
Back to the list
•

In the shipped MFAAS JCL proc required for the Changeman dependent server, a DD CEEOPTS points
at a member in the Mainframe Access parameter library. Because the CHM support changes the ACEE
task to that of the user, the user must have read access Mainframe Access MFA parameter library. If
this is not acceptable, to work around this issue, you need to:
1. Remove the CEEOPTS statement. The EXEC PARM field can be changed to
PARM='TRAP(OFF,NOSPIE)/', if required.
2. Move the CEEOPTS member to a world-readable library.

MFIO
Back to the list
•

Enterprise Developer now includes the SourceConnect functionality.
2807623 (1098289)

Micro Focus Common Client
Back to the list
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•

COBOL Web, EJB, and REST services with Japanese characters in their names can now be deployed
to Enterprise Server.

Micro Focus Directory Server
Back to the list
•

Fixed an issue in the Enterprise Developer Administration HTML GUI if a long user id value was input.

•

2846804 (1102971)
Enterprise Server instance startup performance has been improved, particularly when the Enterprise
Server Administration GUI has been configured to use SSL.

•

2837359 (1101501)
Issue fixed where the Enterprise Server Administration HTML GUI occasionally became unresponsive if
configured to use an SSL browser connection.

•

2834446 (1101342)
The Enterprise Server user id no longer needs to have security administration access permissions to
start an Enterprise Server instance if external security is specified.

Monitoring and Management
Back to the list
•

The Operations Manager agent no longer logs a warning event 21405 for machines being monitored
that do not have Enterprise Server installed .
2830110 (1100895)

PL/I Support
Back to the list
•

A problem when using function names without parentheses in a SELECT statement has been fixed.

•

2850897 (1103138)
A memory leak in IF statements with the ANY built-in function on a CONTROLLED array has been
fixed.

•
•

•
•
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2847413 (1102718)
The -fb7asfb15 compile-time option is now recognized by mfplx.
2846327 (1102571)
The maximum number of PCB parameters under the -systemims compile-time option is now a
maximum of 99.
2846066 (1102523)
A problem with named constants of type BIT has been fixed.
2843898 (1102375)
A non-zero scale-factor supplied to the DIVIDE built-in for FIXED BINARY arguments is now diagnosed
with an E-level diagnostic stating that an integer result will be produced. (Note: scaled fixed binary
arithmetic is not supported.)

•

2842326 (1102119)
A code generator issue causing a runtime SEGV has been fixed.

•

2842145 (1102029)
A problem with the -zalign option causing message MFPLI02000A has been fixed.

•

2842061 (1102034)
A problem when a named constant of type BIT is declared with VALUE ('') has been fixed.

| Resolved Issues

•

2841654 (1102010)
A problem when using function names without parentheses in a SELECT statement has been fixed.

•

2841422 (1101968)
A problem when specifying alternate currency symbols has been fixed.

•

2840770 (1101853)
A problem with the -graphic option when used with mfplx and -sql support has been fixed.

•

2838680 (1101581)
A problem with automatic initialization has been fixed.

•

•

2837702 (1101488)
A problem with initial repetition factors not working for the GRAPHIC and WIDECHAR data types has
been fixed.
2830665 (1100640)
A problem with the RANDOM built-in function has been fixed.
2830364 (1100611)

•

•

Previously, when using the non-standard option -margins 1,72 and the macro preprocessor (or -cics),
additional blank lines were infused into the source code causing the debugger line numbers to be off
and the stepping in the debugger to appear nonsensical. This no longer happens.
2835663 (1101366)
Previously, a CICS program invoked via an EXEC CICS LINK and compiled in EBCDIC was not
generating a proper notification of the load of the shared object. This no longer occurs.
2834253 (1101339)

•

•

•

Previously, if using a hex literal constant that used PL/I continuation rules for -margins 2,72, an infinite
loop would occur in the macro preprocessor. This no longer occurs.
2852567 (1103328)
When using the -incafter and -mvs macro preprocessor options compiling using mfplx, the compiler
erroneously put the %INCLUDE in column 1 before the %IGNOREMARGINS directive.
2844255 (1102268)
Previously, if debugging an application that contained two EXEC CICS statements that appeared
consecutively with no intervening blank lines, upon stepping in the debugger, the debugger would jump
to the middle of the second CICS statement before resuming execution at the proper point on the next
non-CICS statement.
2842819 (1102108)

•

•

•
•

Previously if the DAYS() built-in function was used without the optional "Pattern" parameter, a trap
occurred because the "default" pattern of 'YYYYMMDDHHMISS999' was not supplied to the underlying
routines. This has now been fixed.
2849349 (1103295)
Previously, if using the CODEWATCH notifications and a PUT EDIT triggered a file condition such as
ENDPAGE, the format chain associated with the PUT EDIT statement was not correctly processed upon
resuming after the notification. This has now been fixed.
2842068 (1102012)
A problem with concatenation of GRAPHIC strings has been fixed.
2840750 (1101850)
Previously a KEY condition was incorrectly raised if a KEY(d) read was issued against a VSAM file
which had one or more alternate indexes defined. This has now been fixed.
2838613 (1101607)
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•

•
•

•

•

•
•
•

•

•
•
•

The PL/I preprocessor and DB2 pre-compiler didn't process group variables with SQL TYPE BLOB in
them properly resulting in wrong output for BLOBs. This has now been fixed.
2842781 (1102815)
A problem occurring when an illegal argument passed to the HEX built-in function has been corrected.
2833417 (1100982)
Previously, if a program specified via JCL a RECFM equal to F, FB, FBA, FBS and did not specify an
LRECL but instead depended upon the RECSIZE attribution within the ENVIRONMENT option on the
file declaration, then an UNDEFINEDFILE was incorrectly raised. This no longer occurs.
2838039 (1101528)
When using the Italian EBCDIC Codeset (0039), compiling with -ebcdic and emitting or consuming PL/I
overpunch characters (R or T) the resulting output was not correctly emitted with the X'C0' and X'D0'
characters respectively.
2836438 (1101375)
Previously, if writing to a variable length relative record dataset and the buffer used for the record was
less than the maximum record length, storage corruption could potentially occur. This no longer
happens.
An attempt to read into an automatic variable of a size smaller than that of the largest variable-length
record defined for a file sometimes caused stack corruption.
Previously, if using the DAYS() built-in function from a program executing under Enterprise Server, the
returned result was incorrect. This no longer occurs.
Previously, if two EXEC CICS statements sandwiched a multi-line comment without any whitespace or
PL/I statements containing semi-colons, an additional blank line was generated in the MDECK which
resulted in debugging lines being off by one. This no longer occurs.
Previously, if using the CICS precompiler to compile a filename where the filename's length as specified
exceeded 65 bytes, an erroneous additional %FILE statement was injected on the second macro
preprocessor pass specifying the output file from the CICS precompiler rather than the original source.
This caused a problem for the debugger as the debug information now pointed to a non-existent
temporary file. This no longer occurs.
Previously, if no "-margins" option was specified, the macro preprocessor wrapped at column 256. It
now wraps at column 1023.
The TRIM built-in function is now supported as part of the PL/I Macro Language.
Previously, if using a %REPLACE statement which contained a string with embedded pairs of single or
double quotes to signify that the string literal constant contained a double or single quote, the resulting
%REPLACE wasn't properly re-generated in the output deck. This has now been fixed.

Run-Time System
Back to the list
•

In the JVM COBOL run time, an alphanumeric comparison with a collating sequence now gives correct
results for character values greater than 127.
2839717 (1101845)

•

•

•
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If a file is opened for Read with 'deny neither read nor write' and then the same file is opened for Read
(or Read/Write) with 'deny write', then when the second FD is closed, the 'deny write' file lock was NOT
removed. This has now been resolved.
2837230 (1101419)
64-bit Windows only, and native generated code only. Programs containing code of the form 01 f
comp-2. compute f = f ** 0.5 no longer give a load error at run time (for .gnt code) or fail to link (.obj
code) with the message "unresolved external symbol _tMc4506".
2836893 (1101465)
Under Enterprise Server, a stateful web service containing CICS code no longer hangs if a runtime
error occurs in a nested link level.

•

•
•

2836252 (1101438)
When using "mfauditadm -r" on an audit file containing processes that have very long command lines,
the process could terminate early with a memory fault. This has now been resolved.
2832770 (1101000)
The Sharedmem demo has been updated to make it compatible across all supported UNIX platforms.
Previously, on some platforms the semaphore synchronization did not work.
Repeatedly calling and cancelling different programs in different threads could cause the application to
hang. This has now been resolved.

SQL: COBSQL
Back to the list
•

The COBSQL preprocessor has been updated to correctly handle P(CP) with the NOSQL directive.

•

2850394 (1103086)
Background parse should now create temporary files with names that differ from the actual build
process.
2843719 (1102613)

HCO for DB2 LUW
Back to the list
•

•

A compiler error that resulted from the DB2 ECM preprocessor incorrectly handling embedded
comments within an SQL statement has been fixed.
2846756 (1102646)
An HCO pre-compiler routine incorrectly replaced an underscore in host variable name which resulted
in invalid host variable. This has now been fixed.
2837674 (1101487)

SQL: HCO for SQL Server
Back to the list
•

•
•

•

HCO for SQL Server now supports optimization of DB2 SQL statements by adding SQL Server query
hints, such as OPTION(RECOMPILE), to select, insert, update, and delete statements.
2837973 (1101513)
In certain scenarios, OpenESQL incorrectly handled nested subselects.
2837591 (1101469)
A new SQL compiler directive option, SPCALLLOCAL, is available to transform EXEC SQL CALLs that
invoke stored procedures into COBOL calls that invoke local COBOL subroutines.
2836255 (1101304)
The SQL(SPCALLLOCAL) compiler directive is now available for use with HCO for SQL Server to
enable simulation of DB2 stored procedure execution and the return of result set locators to the caller.
This can improve performance for some applications and deployment scenarios over the alternative of
deploying DB2 stored procedures as SQL CLR stored procedures.

•

2835095 (1101181)
HCO for SQL Server incorrectly converted queries using multiple FETCH FIRST clauses in nested
subselects.

•

2834305 (1101119)
The OpenESQL run-time was updated to correctly locate the HCO for SQL Server SQLCode mapping
file under the Visual COBOL/Enterprise Developer products for VS2012.
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2832258 (1100963)
•

•

•

A problem with SQL(CHECK) producing false errors has been fixed when using SQL Server 2012 or
later versions.
2850575 (1103116)
A problem with HCOSS transformations for IN expressions that use row constructors to TSQL EXISTS
has been fixed.
2844923 (1102580)
An issue where HCOSS did not correctly recognize some OUTER JOIN clauses has been fixed.
2841819 (1102007)

SQL: OpenESQL
Back to the list
•

An overflow problem with host variables of type System.Decimal has been fixed.

•

2849939 (1103195)
OpenESQL has been updated to correctly handle cursors in static methods when using DBMAN=ODBC
in a managed application.

•
•

•

2847268 (1102968)
A problem with EXEC ADO REBIND CONNECTION has been fixed.
2846426 (1102645)
In some scenarios, OpenESQL for ADO.NET incorrectly handled level 49 VARCHAR host variables
defined with zero (0) length.
2845409 (1102510)
HCOSS with SQL(CHECKCALLPARAMS) now correctly determines parameter types and directions for
SQL, SQL synonym, and SQL CLR stored procedure calls that use four-part names, and that are
located on other servers or in other databases.

•

2844292 (1102483)
HCOSS did not fully support DB2 ROW_NUMBER().

•

2843937 (1102362)
Using SQL(CHECK) with .NET applications caused an error on Oracle.

•

2842102 (1102037)
The OpenESQL JVM Runtime was updated to correctly process a FETCH from a VARCHAR column
where the field is zero length.

•

2841149 (1102637)
The Project Properties user interface has been updated to include SYBASE and INFORMIX-NEW on
the COBSQLTYPE options list.

•

2840953 (1101877)
An EXEC ADO GET DATATABLE statement for DataTables contained within a dataset resulted in SQL
errors.

•

2837717 (1101484)
HCO for SQL Server incorrectly returned result set locators for result sets containing VARCHAR(MAX)
columns.

•

2832384 (1101169)
The ADO and JDBC runtimes have been updated to fix a share lock problem that occurred when
SQL(ISOLATION) was set.
2797208 (1096456)

42

| Resolved Issues

•

•

•

•

•

•

To correct a problem when using SQL(DETECTDATE) with SQL Server datetime columns, applications
updating to Visual COBOL 2.3 might require use of the SQL(DETECTDATE) directive if they use SQL
Server datetime columns with PIC X host variables. Alternative solutions are to switch to datetime2, or
to use SQL TYPE TIMESTAMP host variables.
2850022 (1103058)
To correct a problem with closing CURSORs, SQL(SPCALLLOCAL) can now be used to instruct
OpenESQL to detect and close cursors associated with simulated stored procedures not closed by an
application.
2848402 (1102838)
When using SQL Server version 2012 SP2 or later, OpenESQL now supports a [NOCHECK] statement
prefix to enable SQL(CHECK) to be disabled on a per-statement basis. If used with other statement
prefixes, it must come first. When compiling programs that use global temporary tables, HCOSS
executes converted DECLARE GLOBAL TEMPORARY statements at compile time. These enable
subsequent statements that reference the temporary table to be checked using SQL(CHECK).
2847791 (1102782)
OpenESQL now supports SQL(DETECTDATE=SERVER) when using the ADO.NET runtime and SQL
Server version 2012 or later. SQL(DETECTDATE=SERVER) is ignored when using ADO.NET with
earlier versions of SQL Server, and when using any other database.
2846825 (1102701)
When migrating a DB2 application using HCOSS, a compiler error caused by string concatenations that
included literals containing angle bracket characters has been corrected.
2846226 (1102582)
A new directive, CHECKSP, has been added to the OpenESQL preprocessor to verify whether or not
parameters match the COBOL definitions defined in a stored procedure. If not, the OpenESQL
preprocessor generates error ES0127. The syntax is: SQL(CHECKSP=<spd-filename> CHECKSP
applies only when SQL(SPCALLLOCAL) is also used.

•

2844399 (1102329)
The POSTGRESQL parameter for the TARGETDB SQL compiler directive option was erroneously
omitted from the drop-down list in the user interface.

•

2842879 (1102128)
When using the OpenESQL JDBC Managed Runtime with positioned updates on a cursor, an error
occurred when the same cursor was opened and closed multiple times.

•

2841857 (1102003)
The OpenESQL runtime for ADO.NET was erroneously trimming trailing spaces from variable-length
input host variables that used an explicit-length field.

•

2841721 (1102106)
A problem with disconnecting named connections when using the JDBC runtime for OpenESQL has
been fixed.

•

2841508 (616495)
When compiling applications with SQL(DIALECT=MAINFRAME), literals could be corrupted with
embedded spaces.

•

2839826 (1101752)
In European locales, Oracle queries failed to return the decimal symbol for floating point results
returned to decimal numeric host variables.

•
•

2839066 (1102162)
OpenESQL SAVEPOINT handling was not working as expected with Static SQL.
2838227 (1101571)
An HCOSS stored procedure called from multiple locations in either the calling application or in a
nested stored procedure, and that returns result set locators, resulted in an SQLCODE error.
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•

2834386 (1101104)
HCO for SQL Server returned incorrect output parameter values when a CALL statement specified a
stored procedure name in a host variable.

•

2833755 (1101022)
OpenESQL with DATE+EUR erroneously returned values representing a 12-hour clock. Returned
values now correctly represent a 24-hour clock.

•
•

•

•
•

2833683 (1101017)
The SPD Generator did not set the NOTRUNC directive when generating a SQL CLR wrapper.
2829499 (1102075)
When running in ODBC mode, the OpenESQL Assistant DCLGEN sometimes generated incorrect
TIMESTAMP and DATE column sizes. It now generates the TIMESTAMP(6) columns as PIC X(26) and
the DATE columns either as PIC X(19) or X(10) based on the NLS_DATE_FORMAT setting.
2823577 (1099922)
The documentation has been updated to clarify the issue of trailing spaces in comparisons for PIC X
host variables with CHAR and VARCHAR columns.
2806980 (1097582)
An attempt to compile in Visual COBOL with OpenESQL using unsupported HCOSS directives now
returns errors rather than warnings. HCOSS is not supported in Visual COBOL.
OpenESQL for ADO.NET did not recognize and handle Oracle's full managed .NET provider in addition
to the original partially managed provider. Note: The two providers are not 100% compatible. The
partially managed provider uses NLS settings for date/time formatting and the fully managed provider
uses the local machine locale.

SQL Option for DB2
Back to the list
•

The XDB pre-processor incorrectly processed SQL statement that had embedded singles within a
literal. This resulted in receiving an incorrect message "cobsql0111e - no from clause specified error".
2850293 (1103073)

•

When using an open cursor with constants comparison in an IN () clause, an Sqlcode -1352 error
occurred.

•

2844111 (1102266)
An SQL statement with SELECT caused an XDB with Server Violation error when converting from the
CHARACTER to INTEGER type in the INSERT SQL statement.

•

2839382 (1101677)
Incorrect results sometimes occurred when using a host variable for the second parameter of the SQL
scalar function ROUND() function.
2831359 (1101083)

•

Exiting SQLWizard processing no longer causes an exception.

•

2849696 (1103097)
A problem with the display of code page conversions in the SQLWizard Import/Export dialog boxes has
been resolved.

•
•

2846196 (1102659)
An issue that resulted in a syntax error when editing tables with decimal data has been resolved.
2840937 (1101960)
Exporting a table with a reserved word as a column name no longer produces an error X020 if the
quoting types are Apost or Quote.
2806803 (1097559)
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•

An RTS 114 error would sometimes occur on an UPDATE WHERE CURRENT OF CURSOR.

•

2840936 (1101868)
When executing a batch job containing XDB Null loads, an error occurred during DSNUTILB processing
when loading the XICU40N DLL.

•

2840147 (1101785)
An execution error resulted when using dynamic SQL with an SQLDA SQLN integer much larger than
required for input parameter markers.
2818992 (1099256)

XML Support
Back to the list
•

PREXML now terminates and returns an error message if there is a problem expanding a copybook.

•

2472213 (1076394)
XMLPARSE did not honor the encoding in the XML declaration for output text.

•

•

2851343 (1103239)
XML WRITE with CHECK VALIDITY OUTPUT no longer causes RTS 114 error if the written document
contains an XML declaration.
2837110 (1101424)
XMLPARSE did not handle CONTENT-CHARACTERS correctly in XMLSS mode.
2822339 (1099692)

z/Server
Back to the list
•

The TAU0006I message now includes the client IP address and the connection port.

•

2845572 (1102648)
When USS_DUBPROCESS=1 is set, the z/Server givesocket and takesocket functions now continue to
work.

•

2844077 (1102592)
z/Server and Mainframe Access now accept passtickets instead of passwords. RACF and the passticket
generator must be configured correctly and use the same APPLID and signon-keys.

•

2825746 (1100079)
The value specified for VPOOLSIZE in the XML configuration file was ignored and a default value of 4K
was used instead. The value specified by the user is now being honored.
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
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2266906 (1066314)
2541594 (1081441)
2610077 (1087571)
2613606 (1088533)
2691674 (1093498)
2784725 (1095083)
2792882 (1102055)
2801626 (1097006)
2801847 (1097374)
2805056 (1097357)
2806566 (1097816)
2807649 (1097763)
2809132 (1097892)
2812331 (1098359)
2815582 (1099634)
2817630 (1101066)
2824712 (1100086)
2824925 (1099961)
2825098 (1100032)
2825249 (1101374)
2827707 (1100302)
2828305 (1100419)
2828897 (1100491)
2829677 (1100588)
2830741 (1100655)
2830871 (1100785)
2831477 (1100831)
2831788 (1100810)
2831959 (1100864)
2832490 (1100907)
2832904 (1100916)
2833083 (1101060)
2833100 (1101123)
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•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2833473 (1101007)
2833925 (1101045)
2834217 (1101124)
2834245 (1101085)
2834253 (1101099)
2834843 (1101156)
2834959 (1101167)
2835289 (1101498)
2835416 (1101496)
2835506 (1101288)
2835508 (1101292)
2835599 (1101293)
2835608 (1101494)
2835687 (1101497)
2835835 (1101262)
2836694 (1101356)
2837531 (1101490)
2837784 (1101511)
2838086 (1101525)
2838343 (1101586)
2838426 (1101552)
2838593 (1101986)
2838671 (1101587)
2838689 (1102052)
2839730 (1101776)
2840155 (1101821)
2840349 (1101906)
2840530 (1101860)
2840658 (1101893)
2840766 (1101857)
2840977 (1102019)
2841607 (1101961)
2841785 (1101988)

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2841933 (1102021)
2842318 (1102129)
2842702 (1102121)
2842940 (1102122)
2843048 (1102186)
2843076 (1102135)
2843140 (1102509)
2843301 (1102185)
2843324 (1102296)
2843438 (1102240)
2843446 (1102173)
2843446 (1102174)
2843884 (1102492)
2845184 (1102627)
2845218 (1102490)
2845635 (1102601)
2845781 (1102730)
2846150 (1102557)
2846669 (1102644)
2846797 (1102780)
2846971 (1103070)
2847253 (1102806)
2847876 (1102765)
2848324 (1103143)
2849271 (1103044)
2849307 (1102974)
2849430 (1103011)
2849508 (1102970)
2849972 (1103094)
2851114 (1103175)
2851169 (1103174)
2852143 (1103362)

Installation
Before Installing
Downloading the Product
1. Use the download links in your Electronic Product Delivery email.
For more information follow the links for the installation instructions and the End User License
Agreement.

On Windows
System Requirements
Hardware Requirements
Enterprise Developer has the following requirements in addition to the requirements of Eclipse. See the
Eclipse documentation for details of its requirements.
In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM though Micro Focus recommends at least 4GB of RAM for optimal performance.
The disk space requirements for Windows are, approximately:
Enterprise Developer

Sentinel RMS License Manager

4.5GB

75MB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Enterprise Developer setup file. This includes the space
needed to cache information locally so that you can modify the installation without the original source
media.
z/Server requirements
z/Server has the following hardware requirements:
•

IBM mainframe model z9 or later is required for installing and using z/Server. z/Server will not install on
earlier hardware models.

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
Note:
•
•

Enterprise Developer enables you to produce both 64-bit and 32-bit applications on 64-bit
operating systems.
This product can be installed on earlier versions of Windows but it has not been tested on them.
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Software requirements
Note: This product includes OpenSSL version 1.0.1p.
The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.
Eclipse requirements
•

The setup file installs Enterprise Developer and Eclipse 4.4.2.

•

See Installing Enterprise Developer into other instances of Eclipse for instructions on how to install
Enterprise Developer into other instances of Eclipse installed on your machine.
Enterprise Developer does not support the 64-bit Eclipse. You can, however, use the 32-bit Eclipse to
create both 32-bit and 64-bit applications.
Enterprise Developer requires a 32-bit Java installation.

•

Software requirements on Windows
•

•

Oracle's Java Platform, Enterprise Edition (Java EE) Java 7 or Java 8 is required to execute COBOL
JVM code and for native COBOL and Java interoperability. You can download Oracle's Java EE from
Oracle's web site and install it anywhere on your machine.
Note: If Java 7 is installed on your machine, to skip installing Java 8, run the Setup file with the
skipjre=1 command line option.
The setup file also installs .NET Framework v4.5.2 and the Microsoft Visual C++ 2010 and 2012
Redistributables.

See the Java Support Considerations for the Eclipse IDE in the Known Issues and Restrictions section in
your product help for considerations that apply to using the Eclipse IDE and Java.
Other Requirements
Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Enterprise Developer client and a new licensing server on the same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.
Additional Software Requirements on Windows
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.
Click here to see this information in the Micro Focus Infocenter.
Database Access - Mainframe Batch Database Tools (MBDTs)
Back to Top
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Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use and it
is not supported as such.
Availability

Feature/Platform
x86-64 running Windows

32-bit

64-bit

X

X

OpenESQL The MBDTs are OpenESQL applications, and are native code using ODBC. Please see the
Database Access - OpenESQL section for further details.
Testing

For this version, the MBDTs were tested with:
•
•
•

DB2 LUW 10.5
Oracle 12.1
SQL Server 2012

Product Co-Existence
Note: The following applies to Windows only.
•
•

Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same
machine.
Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements
Before starting the installation you should consider the following:
•

You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

•

Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped
and uninstalled. On Windows, do this as follows:
1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:
net stop mf_ccitcp2
Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.
For MFDS, from a command line prompt enter: mfds -u
For CCITCP2: ccitcp2 -u
To run an earlier version of MFDS as a service after you have installed a later version:
1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:
a. Open an Enterprise Developer command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2
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Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.
MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.
It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

On UNIX
System Requirements for Micro Focus Enterprise Developer UNIX
Components
Hardware Requirements
The disk space requirements for Micro Focus Enterprise Developer UNIX Components are approximately:
Platform

Installer type

Setup

Disk space

Disk space

Sentinel RMS

file size

required for

required for

(MB)

the installation

running

license
server

the product

(MB)

(MB)
POWER
running AIX

Micro Focus installer

479

1.91 GB

958

36.5

HP IA

Micro Focus installer

866

3.46 GB

1.73 GB

69

System Z
running Red
Hat Linux

Micro Focus installer

390

1.56 GB

780

36

x86-64
running Red
Hat Linux

Micro Focus installer

431

1.72 GB

862

46

SPARC
running
Solaris

Micro Focus installer

492

1.97 GB

984

40

System Z
Micro Focus installer
running SUSE
SLES

394

1.58 GB

788

36

x86-64
Micro Focus installer
running SUSE
SLES

437

1.75 GB

874

46

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
Software Requirements for Micro Focus Enterprise Developer UNIX Components
These are the software requirements for Micro Focus Enterprise Developer UNIX Components:
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•

•

The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax -version at the command line.
The following operating system libraries must be installed:
Library

Platform
SUSE 11

SUSE 12

Red Hat 6.x

Red Hat 7

glibc-locale-32bit

X

X

gcc

X

X

gcc*.i686

X

X

glibc-*.x86_64

X

X

glibc-*.i686

X

X

libgcc-*.x86_64

X

X

libgcc-*.i686

X

X

libstdc++-*.x86_64

X

X

libstdc++-*.i686

X

X

gdb*

X

X

X

X

elfutils-libelf-**

X

X

X

X

libelfdevel-0.137-8.19
**

X

X

X

X

libelf1-0.137-8.19* X
*

X

X

X

libelf1-32bit-0.137- X
8.19**

X

X

X

* Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the
GNU Project Debugger) can be installed from the install media for your OS.
** Operating system libraries required for PL/I support on both SUSE and Red Hat.
Visit the Red Hat Web site for more information.
•

Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

•

Oracle's Java Platform, Enterprise Edition (Java EE) 7 or Java 8 is required to run the Eclipse IDE, to
execute COBOL JVM code and for native COBOL and Java interoperability. The setup file installs Java
8 u51 32-bit. You can download Oracle's Java EE from Oracle's Web site and install it anywhere on your
machine.
Note:
•
•

On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.
On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

To execute COBOL JVM code, you need to set the environment as follows:
•

You need to set the JAVA_HOME environment variable. When installing the product, set this variable
to a 32-bit Java installation or the installation terminates. For example, execute the following:
JAVA_HOME=java_install_dir
where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
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•

•

You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

•

export PATH=$JAVA_HOME/bin:$PATH
You need to set the LANG environment variable to pick up localized messages. The LANG settings
are English and Japanese only.

GNOME menus and buttons have been standardized across all applications so that icons are not
displayed by default. To keep the icons and the look and feel of previous versions, enable the
menus_have_icons property with the command:
gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have_icons
true

Additional Software Requirements for Micro Focus Enterprise Developer UNIX Components
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.
Click here to see this information on the Micro Focus Infocenter.
UNIX and Linux Installer Issues
Installing on Linux
On Linux, the 32-bit version of Java is required to install and use Enterprise Developer for Eclipse. When
you start the installation, if the 64-bit version of Java is already installed on your Linux machine, you might
not be able to install Enterprise Developer. This is a known issue with the Oracle Java installers for Linux
which prevent you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To
work around this problem:
•
•
•

Download the 32-bit Java distribution in a compressed .tar format from the Oracle Web site.
Untar the distribution into a location different from the one used for the 64-bit Java version. For example,
untar in /usr/local/java32 and not in /usr/local/java.
Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is used to install and
run Enterprise Developer.

License Server
You need to configure the computer hostname to ensure the license server will start properly.
To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.
The following is an example of how to specify these entries correctly in the etc/hosts file:
127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname
where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.
For considerations when installing this product as an upgrade, for additional installation options or nondefault installations and for installing the mainframe components, see Advanced Installation Tasks.
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Installing on Windows
Note:
•
•

This version of the product is a full install.
If you have an earlier version of Enterprise Developer installed on your machine, check Installing
as an Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Enterprise Developer:
1. Run the ede_231.exe file and follow the wizard instructions to complete the installation.
By default, this installs Enterprise Developer in the %ProgramFiles(x86)%\Micro Focus
\Enterprise Developer folder and installs a full version of Eclipse 4.4.2, with the Micro Focus
plugins already installed, in the C:\Users\Public\Micro Focus\Product Name\eclipse
directory.
The setup file installs any missing prerequisite software as listed in the topic Software Requirements.
Note: See Advanced Installation Tasks for information about non-default installation tasks. For
example, if you have Java 7 installed on your machine and you want to skip installing Java 8, run the
setup file from the command line with the skipjre=1 command line option.

Installing Micro Focus Enterprise Developer UNIX
Components
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.
These are the steps to install this product using the Micro Focus installer:
1. Give execute permissions to the setup file:
chmod +x setup_entdev_2.3_update1_platform
2. Run the installer from the Process User ID login:
./setup_entdev_2.3_update1_platform
When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.
The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR).
SafeNet Sentinel considerations
•

•

The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:
./setup_entdev_2.3_update1_platform -skipsafenet
To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:
touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.
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Note:
During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.
All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.
By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.
The advanced installation tasks include:
•
•
•
•
•
•
•

Installing as an Upgrade - included in these Release Notes
Command line installation options - included in these Release Notes
Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus
Infocenter
Installing and licensing Micro Focus Rumba - available in the product Help and in the Micro Focus
Infocenter
Installing into other instances of Eclipse - available in the product Help and in the Micro Focus
Infocenter
Installing the Mainframe Components, - Mainframe Access Server, Application Workflow Manager into
RDz, z/Server - available in the product Help and in the Micro Focus Infocenter
Installing on Microsoft Terminal Server and Citrix - available in the product Help and in the Micro Focus
Infocenter

Click here to see this information on the Micro Focus Infocenter.

On Windows
Installing as an Upgrade
•

If you have been using the mainframe components of Enterprise Developer for z Systems, see Installing
z/Server as an Upgrade for recommendations about how to upgrade your z/Server installation. Also,
check Backward Compatibility of AWM Models for information about changes that affect your existing
AWM models.

•

Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Enterprise Developer Installation Options
You can install Micro Focus products silently by specifying /q at the command line and using command line
parameters to specify the installation directory (installfolder=path), user information, and which
features to install. You must execute the command with superuser permissions.
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To see what parameters you can use, execute the following from the command line:
install-file /help
where install-file for the following products is as follows:
Enterprise Developer

ede_231.exe

See the Examples section further in this topic for examples of some of the parameters you can use.
Directory considerations
•
•

You must have read and write access for every directory accessed during the installation.
You can override the default installation folder using the InstallFolder parameter.

•

Installing creates a group of log files prefixed Micro_Focus_ in the %temp% folder, by default. To
change the location or name, use the /log parameter on your Setup command line and specify the
path and file name, for example:
/log drive:\path\LogFilename

Installing silently
Use the /q parameter to install silently:
start /wait install-file.exe /q [parameters]

Examples
•
•

To silently install Enterprise Developer into a directory other than the default:
start /wait ede_231.exe /q InstallFolder=c:\DirectoryName
If you want to silently install the Eclipse IDE in a location other than the default, execute:
start /wait ede_231.exe /q InstallFolder2=c:\EclipseInstallDirectory

•

To skip installing JRE when installing Enterprise Developer:
start /wait ede_231.exe /q skipjre=1

•

To silently install Rumba during the silent install of Enterprise Developer:
start /wait ede_231.exe /q RumbaCheckbox=1

On UNIX
Installing as an Upgrade
This release works concurrently with the previous version of Micro Focus Enterprise Developer UNIX
Components, so you do not need to uninstall it. There are two options for installing the latest version in this
case:
•

Move the existing installation to a different location and install the latest version to the default install
location specified by the COBDIR environment variable (/opt/microfocus/
EnterpriseDeveloper, by default).
This ensures you do not need to change your environment. To move the existing older installation to a
different location:
1. Execute the following command as root:
mv /opt/microfocus/EnterpriseDeveloper /opt/microfocus/
EnterpriseDeveloperversion
2. Install the latest version as described in the section Installing.
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•

Install the latest version in a different location and set the environment to point to it. To do this, run the
Micro Focus Enterprise Developer UNIX Components installer with the –installlocation option:
1. Execute the following command:
. /InstallFile -installlocation="/opt/microfocus/EnterpriseDeveloper"
Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:
-installlocation="/home/myid/installdir"
-installlocation="~myid/installdir"
-installlocation="~/installdir"
-installlocation="$HOME/installdir"
2. Execute cobsetenv to set the environment and point to the new install location:
. /opt/microfocus/EnterpriseDeveloper/cobsetenv
Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Micro Focus Enterprise Developer UNIX Components Installation
Options
Installing into a different location
To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:
./setup_entdev_2.3_update1_platform -installlocation="full path of new
location"
Note: You can use variables or the tilde syntax for the path for –installlocation. For example,
the following examples are equivalent:
-installlocation="/home/myid/installdir"
-installlocation="~myid/installdir"
-installlocation="~/installdir"
-installlocation="$HOME/installdir"
You can see details about which additional parameters can be passed to the install script if you enter the help option.
Configuring the Enterprise Server installation
You can use the following options to configure the Enterprise Server installation: [ ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:
-ESsysLog

Specifies a location in which the build will create the Enterprise Server System log file - for
example, -ESsysLog="/home/esuser/logs". The default location is /var/mfcobol/
logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line for example, -ESadminID="esadm". The default user ID is the one that runs the installer.
-CASrtDir
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Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.
You can use the following command line arguments to install silently on UNIX/Linux:
–silent -IacceptEULA
For example, execute:
[as root] setup_filename –silent -IacceptEULA

After Installing
•
•

See Changes in Behavior or Usage in your product documentation and in the Release Notes for
important information about changes in this release that might affect existing applications.
Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Configuring Enterprise Developer
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:
1. Open the existing workspace with this product.
You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Open Perspective >
Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

On Windows
Installing X Windows on Windows
Some features of Enterprise Developer for Eclipse on Windows require an X Windows installation, hence
Micro Focus ViewNowX is provided with the product. To install, run the file ViewNow_X_Server.exe in
your Enterprise Developer installation. By default this will be in the %ProgramFiles(x86)%\Micro
Focus\Enterprise Developer\ViewNowX folder.
ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing on Windows
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
To repair your installation on versions of Windows Vista or later:
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1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:
1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.
When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.
Note: The installer creates separate installations for Micro Focus Enterprise Developer and Micro
Focus License Administration. Uninstalling only Enterprise Developer does not automatically uninstall
the Micro Focus License Administration or any of the prerequisite software.
To completely remove the product you must uninstall the Micro Focus License Administration as well.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
Some registry entries are not removed by the uninstallation process and you need to manually delete
them.
The following folders might not be removed:
•
•
•
•

The Micro Focus Product Name folder in the Start menu - you can delete it manually.
%systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log
files of the samples which you have built.
%ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
%Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:
start /wait install-file.exe /quiet /uninstall
In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:
•
•

Micro Focus Server\Performance\Active Servers
Micro Focus Server\Performance\PerfIniFile

On UNIX
Configuring the Remote System Explorer Support
The remote development support from the Eclipse IDE relies upon Enterprise Developer running on the
UNIX machine and handling all requests from the IDE for building and debugging programs. Enterprise
Developer provides a UNIX daemon, the Remote Development Option (RDO) daemon, which initiates the
RDO as Eclipse clients connect to it. Whichever environment is used to start the RDO daemon will be
inherited for all servers and hence all build and debug sessions.
Configuring the Environment
You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated from one of the Eclipse clients, the environment used will be
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inherited from whatever was used to start the daemon. A typical example of the kind of environment that
might need to be set up would include database locations and settings for SQL access at build/run time.
Starting the Daemon
Important: Before starting the daemon you must have the following on your UNIX machine:
•
•
•

a version of Perl
a version of Java
the as (assembler) and ld (linking) programs on the path, as specified by the PATH environment
variable

To start the daemon on the default port (4075) as a background process, perform this command with
superuser authority:
$COBDIR/remotedev/startrdodaemon
The daemon will now listen for any Eclipse client processes connecting to that machine on port 4075. If
you want to use another port, specify another port number on the startrdodaemon command.
The daemon can also be configured to instantiate the servers on a specified port or range of ports. This is
particularly relevant when you want to only open certain ports through a firewall. To do this, perform this
command with superuser authority:
$COBDIR/remotedev/startrdodaemon [<port> | <low port>-<high port>]
where:
•

<port> is the port number the daemon should use to listen for connections from Eclipse on the client
machine. If no value is given, it will be assigned a default value of 4075. This value matches the value
assigned within the Eclipse installation.
For example,
$COBDIR/remotedev/startrdodaemon 4999

•

This command will start a daemon listening on port 4999 and will use random server ports.
<low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use
to communicate with Eclipse on the client machine.
For example,
$COBDIR/remotedev/startrdodaemon 4080 4090-4999
This command will start a daemon listening on port 4080 and server ports will be in the range 4090 to
4999.

Stopping the Daemon
To stop the daemon, type the following command with superuser authority:
$COBDIR/remotedev/stoprdodaemon <port>

Repairing on UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.
To uninstall this product:
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1. Execute as root the Uninstall_EnterpriseDeveloper2.3.sh script in the $COBDIR/bin
directory.
Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.
To uninstall Micro Focus License Administration:
1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.
The script does not remove some of the files as they contain certain system settings or licenses.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:
•
•
•

If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.
Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To start Micro Focus License Administration
Windows
From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.
Note: On Windows 8, Windows 10, and Windows Server 2012, you use the Start screen to invoke
programs.
UNIX
Log on as root, and from a command prompt type:
/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses
If you have a license file
Windows
1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:
•

Click Browse next to the License file field and select the license file (which has an extension
of .mflic).
• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.
4. Click Install Licenses.
Alternatively, you can install the license file from within the IDE as follows:
1. Start Enterprise Developer.
2. Click Help > Micro Focus > Product Licensing to open the Product Licensing dialog box.
3. Ensure I have a full Enterprise Developer Team Edition license is checked.
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4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mflic), and then click Open.
6. Click Finish to install the license.
UNIX
1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.
2. Enter the name and location of the license file.

If you have an authorization code
Authorizing your product when you have an Internet connection
The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.
Windows
1.
2.
3.
4.

Start Micro Focus License Administration.
Click the Install tab.
Type the authorization code in the Enter authorization code field.
Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.
UNIX
1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.
Windows
1.
2.
3.
4.

Start Micro Focus License Administration.
Click Manual Authorization on the Install page.
Make a note of the contents of the Machine ID field. You will need this later.
Do one of the following:
•
•

If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.
If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
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8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.
10.Click Install Licenses.
UNIX
In order to authorize your product you must have the following:
•
•

Your authorization code (a 16-character alphanumeric string).
The machine ID. To get this, start the Micro Focus License Administration tool and select the Get
Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.
1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.
2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.
3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by
inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:
•
•
•

The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.
The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.
The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support.
Note: Some information may be available only to customers who have maintenance agreements.
If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.
Also, visit:
•

•

The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.
The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.
•
•
•
•
•
•

The name and version number of all products that you think might be causing a problem.
Your computer make and model.
Your operating system version number and details of any networking software you are using.
The amount of memory in your computer.
The relevant page reference or section in the documentation.
Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
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Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.
On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:
•
•

a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.
a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.
To run MFSupportInfo:
1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:
a. To create a .log file, click File > Save.
This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.log, in the %temp% directory.
b. To create a .zip archive, click Tools > Create Zip Package.
This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.zip, in the %temp% directory.
4. Send the diagnostic information to your Micro Focus SupportLine representative:
The following requires an Internet connection and an Email client:
a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.
If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.
On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.
To run mfsupport:
1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.
This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.
Note:
If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.
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If COBDIR is set to a location that does not contain etc/cobver or COBDIR is not set, mfsupport
gives you the option to search your machine for possible product locations. Note that the search can
take some time if you have a large amount of disc storage and files.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.
Micro Focus is a registered trademark.
Copyright © Micro Focus 1984-2016. All rights reserved.
This product includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/)".
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